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1.2

1.3

1. Release Notes

Background / Environment

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and
Leasing solution. The suite is a comprehensive, end-to-end solution that supports full lifecycle of
direct and indirect consumer lending business with Origination, Servicing and Collections modules.
This enables financial institutions to make faster lending decisions, provide better customer service
and minimize delinquency rates through a single integrated platform. It addresses each of the
lending processes from design through execution. Its robust architecture and use of leading-edge
industry standard products ensure almost limitless scalability.

Purpose

The purpose of this Release notes is to highlight the enhancements and bug fixes included in the
Oracle Financial Services Lending and Leasing Release.

Abbreviations

Abbreviation | Detailed Description
OFSLL Oracle Financial Services Lending and Leasing
XML Extensible Mark-up Language
XSD XML Schema Definition
GL General Ledger
XLF Extended Log Format
JSF Java Server Faces
EAR Enterprise Application Archive
ul User Interface
WSDL Web Services Description Language
ACH Automated Clearing House
MDB Message Driven Bean
JMS Java Messaging Service
loT Internet of Things
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1.4

1.5

Product Summary

Oracle Financial Services Lending and Leasing Release built to meet various challenges faced by
financial institutions. It addresses each of the lending processes from design through execution. Its
unique value lies in its ability to provide the business with predefined processes and an excellent
framework that takes care of business risk and compliance needs.

Release Highlights

The key highlight of this patch release is to fix the critical bugs and to enhance the industry specific
requirements.
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2. Enhancements

Enhancement

Description

Functional Enhanceme

nts

Master Account

This feature gives a flexibility to Mark an Application/Account as Master
Account and link other Accounts (Loan, Line, and Lease) of the Customer to
this Master Account. With this Linking, financial Institutions benefits to:

- Link new application from customer to existing Master Account

- Make Payment to Master Account and apply to all its associated
Accounts

- Post transactions (Payoff Quote, Due Date Change, ACH, and
Extension) at Master Account to update all Associated Accounts.

- Generate consolidated statement of all associated accounts.

- Complete view of the Customer->Master Account->Associated
Accounts

Detailed information about the functionality is available in subsequent
section.

Business only Account
(SEV,COL)

This Enhancement provides ability to create Business only
Applications/Accounts in OFSLL without the need to add a Primary
Application/Customer. This is phase 1 of the total enhancement followed by
phase 2 in future release. Broad level impact areas handled are as follows:

- Correspondence/Letters

- Correspondence recipients

- Disable Customer tab on tagging Account as Business only
- AP Transactions (Business Only Radio button)

- New Business Transaction

- Changes in batch jobs to include Business only Accounts (Customer
Refund Payment Requisitions, Customer Payment File Upload,
Customer Statement Letter, Customer Statements Generation)

Note: This enhancement is only for Servicing and Collections modules.

Customer Credit Limit
Expiry Date Validation
in Servicing

This is an update to the Existing Customer Credit Limit functionality with a
validation on the Customer service transactions based on the Limit Expiry
date.

Auto Contract From
OFSLL Ul

This is a usability enhancement with a new Suggest button in Contract
screen to load an instrument based on the configuration. This reduces the
number of steps followed to select instrument and complete the Contract.

However, Suggest option is not available if instrument is already loaded.

2-1 ORACLE
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Enhancement Description

Criteria based This feature gives a capability for financial Institutions to define and post
Condition Posting criteria based conditions on an Account which in-turn can perform multiple
actions such as build a Queue; configure an Event, Transaction Access
Control and so on.

Some of the Business cases achieved with this enhancement are:

e Generate special condition based on Account Maturity date less than
90 days from system date (Days to Account get Matured)

— Send Letters
— Post Transactions, etc.
e OQutstanding Ratio (Current Amount Outstanding/Amount Financed)

— Replaying 50% of financed amount, system allows posting
extension transactions.

* Collateral coverage ratio

— Ability to define condition posting based on Collateral
Coverage ratio and define an action

e Give ‘Extension’ to Accounts in a particular zip code affected with
natural calamity.
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Enhancement

Description

Events Phase |l
Enhancements

‘Events’ functionality has been enhanced with the following features to
provide configuration capability to the financial institutions.

New ‘Events’ framework is enhanced with below features:
e Common Event framework definition for Loan/Line/Lease modules.

e Support of creating custom JSON JMS Message based on Event
Response User Defined Tables.

e New ‘Event’ indicator in transaction codes to indicate transactions
allowed for Event Types and Event Actions.

e New Event Types are added for:
0 Monetary and Non-Monetary Transaction
o0 New Bankruptcy Create and Update
e New Event Actions are added for below Entity Types
o Account
= Post Call Activity
= Create Monetary and Non-Monetary Transactions
= Send Correspondence and Letters
= Create Work Order, Review Request and Comments
= Request Credit Bureau
o Customer
o Create Comment

Below are some Business case examples related to Customer:

Customer Address is created Post an custom automatic
comment with Alert

Customer Address is created Send JMS to Customer Hub
Customer Address updated Send JMS to Customer Hub
Customer Telecom created/updated Send JMS to Customer Hub

Customer Employment Created/update | Send JMS to Customer Hub

2-3 ORACLE
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Enhancement

Description

Below are some Business case examples related to Account:

Account Condition created/updated

Send Custom JMS

New Transaction Posted

Send Letter

New Account Created

Send Webhook to Customer
self-service portal

Bankruptcy created/updated

Send Letter

Bankruptcy created/updated

Send JMS

Bankruptcy created/updated

Send Webhook to Attorney

Repossession Created/Updated Send JMS to 3rd Party

Webhook
Implementation

Webhook framework has been created to notify third-party applications using
OFSLL Events with following features:

e Call back mechanism to third party applications from OFSLL

e Setup to create Webhook channel to record third-party interfaces
e Register OFSLL Events with Webhook Channel

e View status of transmission of message

e Retrigger failed messages

Ul Extensibility and
Label Configuration

Ul Extensibility currently supporting only Producer screen has the following
features:

e 20 new user Defined Fields added (10 text, 5 date and 5 Number)
e Ability to enable/disable User Defined Fields

e Ability to configure the Ul label

e Ability to configure the base product label’'s and define custom label

Account level flag to
identify Securitization
Eligibility

Account level ‘Securitization Eligible’ flag is available to identify if account
qualifies for securitization.

Customer Score
Refresh

Facility to maintain record of Customer scores for Customers and Business.

Interface (File Upload) Enhancements

Ability to upload
account onto the
Securitization pool

File upload facility provided to add accounts to pool, remove accounts from
pool and transfer account from pool.

Collateral Upload File

File upload facility provided to add Collaterals on to the Collaterals.

Input File Processing
Enhancements

Enhanced the Input File Processing batch job.
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Enhancement

Description

New Transactions and

related Enhancements

Add Existing Customer
to an Account

New non-monetary transaction to map existing customer in OFSLL to
account.

New Asset Transaction

New transaction to associate an existing Asset to Account.

Add Business
Customer to the
Account from Ul

Ability to add business Customer on to the Account from User Interface.

Add button is available on the Business tab to add a new Business Customer
and disable old Business customer.

Rate Increase /
Decrease transaction

Ability to Increase/Decrease the Rate of Interest on the Account.

New transactions to
update and have
history of Customer
scores for Individual
and Business.

e On posting ‘Customer Score Update’ transaction, details are captured
under ‘Customer Service > Customer Details > Customer > Customer
Score (new tab).

e On posting ‘Business Score Update’ transaction, details are captured
under ‘Customer Service > Customer Details > Business > Business
Score (new tab).

Reason Code field to
map to all non-
monetary transactions

‘Reason Code’ seed data is available in User defined tables. On mapping the
same to any non-monetary transaction, captures the reason while posting
the transaction.

Conversion Enhancements

Conversion
Enhancement for Line.

User Interface enhancements to show Line Accounts in the Account
Conversion screen.

Conversion Using a
File upload — Condition
upload.

Enhanced Conversion process to consume account conditions dat file.

Conversion Using a file
upload — Bankruptcy
Information

Enhanced Conversion process to consume ‘Bankruptcy’ information dat file.

Link Customer Based
on Customer Number

Note: This details are
added during
subsequent update
during April 2021

Following set of new system parameters are introduced to determine if
Customer/Business/Asset number are to be auto generated during account
on-boarding/Conversion process.

SYP_AUTO_GEN_BUS_NBR
SYP_AUTO_GEN_CUS_NBR
SYP_AUTO_GEN_ASE_NBR
SYP_LINK_EXISTING_CUSTOMER
UPR_PRO_NBR_SYS_GENERATED
UVN_VEN_NBR_SYS_GENERATED

Technical Enhancements
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Enhancement

Description

Extensibility
Enhancements

Following extensibility is supported with current release:

e Satellite applications access from base application through OAuth 2.0
token based REST service authentication.

e User Defined Extensible fields at each Entity in all layers Ul, Services,
backend (Producer Screen).

EBR Enhancements —
Phase I

EBR enables online application upgrade with uninterrupted availability of the
application. When the installation of an upgrade is complete, the pre-upgrade
application and the post-upgrade application are available at the same time.

¢ Replaced table references with base view in all EVW, FVW and JVW,
RVW, SVW, Views references

e Created View for all tables

e Added intelligence to installer to create BVW as editionable / non-
editionable based on configuration of schema.

Lease Seed Data
updates

Enhanced Lease module with seed data to compute default Fee Balances.
Transaction added for Inspection Fee, Damage Fees, Reconditioning Fees,
Purchase Fee, Inspection Fee, and Transportation Fee.

Web service changes

Following web services are introduced:
e Generate OAuth2.0 Token

Validate OAuth2.0 Token

Webhook

Vendor

Vendor Comments

Producer

Producer Comments

Producer Contacts

Producer Compensation

Producer Statements

Producer Subvention

All Account Tracking Attributes

Monetary Transaction History

Asset

Asset Valuation

SOAP Web service
Deprecation

From the current release, deprecated all the existing SOAP services from
base version.

Change to existing
Web services

Following web services are modified:

Account On-boarding
Account Details

Account Search Service
Payment Posting
Customer Payment Posting
Business Payment Posting
Asset

Associate New Asset
Transaction

New Non-Monetary transaction is available to associate non-primary asset to
an Account.
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211

Master Account

Overview

This feature gives flexibility to Mark an Application/Account as Master Account and link other
Accounts (Loan, Line, and Lease) of the Customer to this Master Account. With this Linking
Financial Institute will get the benefits like:

Link a new application from customer to Existing Master Account.

Link a new account as an Associated Accounts to a Master Account using Master Account
Maintenance Transaction in servicing.

Make Payment at Master Account and apply to all associated Accounts.

Ability to post Transactions at Master Account/Associated Accounts which will update all
Associated Accounts (Payoff Quote, Due Date Change, ACH, Extension).

Consolidated Statement at Master Account.

Complete View of the Customer->Master Account->Associated Accounts.

Origination Changes

1. A new Master Account tab is added under Origination >Application tab next to contract tab.

EDIT, VIEW and AUDIT buttons are available in this tab.
Following fields are available in Master Account tab.

. Field Mandator
Field Name Type LOV Values V(Y/N) Comments
Check this Check Box to mark a
current Application as Master
Check Account.
ec
Master Account | 5. | NA Y Once this check box is checked
“Link to Existing Master Account”
LOV will be refreshed “NULL” and
made Read Only.
This field will be refreshed to
NULL and Read-Only, if the
Master Account Check box is
Derived from checked.
Master Use this LOV to link the current
Accounts application to an existing Master
created under Account.
Linked L .
Lk to Existin customer to This field will show the
Master Accougt LOV Current N : <<Relationship Type>> - Title -
Application and Master Account #
the “Link to L .
Existing Once an application funded with

Customer” flag
=Y at Contract

().

Link to existing Master Account
field, system will attach the
respective account under that
Master Account by populating the
selected Linked Master Account #
in Master Account # field of newly
created account in servicing.

2-7
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Example:

Marking an Application as Master Account:

Application 1001 : Masrked as Master Account
After Funding : Account # = 23120191001
Master Account # = 23120191001

Linking an Application to Existing Master Account:

Application 1002 : Link to Existing Master Account # = 23120191111
After Funding : Account # = 23120191002
Master Account # = 23120191111

e Following Contract EDIT added to ensure Billing Cycle and Due day of current application
should be same as the Master Account Billing Cycle and Due Day if the current
application is going be link to an Master Account.

Edit Name Default Type | Enabled
BILLING CYCLE AND DUE DAY DOES

NOT MATCH WITH THE MASTER Warning N
ACCOUNT

> If the current application billing cycle and due day is not matching with Master
Account, system fires the “Billing Cycle and Due day are not matching with Master
Account” edit.

> If current application is linked to existing master Account and product is having
“Same billing cycle flag = Y” system will not validate the billing cycle and due day
based on same billing cycle flag, the precedence is given to Master Account Billing
cycle and Due day.

e Following Contract EDIT added to ensure Product Type of current application should be
same as the Master Account Product Type if the current application is going be link to a
Master Account.

Edit Name Default Type | Enabled

PRODUCT TYPE DOES NOT MATCH

WITH THE MASTER ACCOUNT Warning N

> If the current application Product Type is not matching with Master Account, system
will fire the “Product Type not matching with Master Account” edit.

e Following EDIT is added to validate Master Account and Application which is going to be
Associated are belongs to same Company.

Edit Name Default Type | Enabled
CURRENT AND MASTER ACCOUNT

SHOULD BELONG TO THE SAME Error N
COMPANY

2. If user wants to create the current application as Master Account, need to check the Master
Account check box and once the application is funded, system populates the Master Account
# same as Account # in servicing.
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If the Account # received from external system and the application is marked as Master
Account as part of Onboarding, system populates same Account # in Master Account # field
once the application funded.

A new “Statement Consolidation” flag is added at Origination >Contract (2) and default value
is 'Y’

e Propagates this flag to servicing >Account Details and Contract (2) as part of funding.

Unigination o] Close
Conlract (2} PRepsyment Remizations Tradeln Subvention Inswances ESC  Compensstion  Proceeds Disbursements Fees ACH  Coupons  Releresces

a view o Audit

Cellestar Lien Sratus HOERA fate Spread
USHY DEMO COLLECTOR ORIGINATED OR PURCHASED- ROT HOERA 0.0000

Other Delaiks

Hebate

Telersnce

Above-mentioned fields added to Master Account section in following web services and API
process.

e Account On-boarding
e Account Conversion (APl Process).

Following validations are applicable to above web services and API process.

> If the Current Application marked as Master Account by checking the “Master
Account” check box.
- Once this check box is checked, “Link to Existing Master Account” field is not
required.
- An edit added to validate “Linked to existing Master Account” field not required
when “Master Account” check box is checked.

- If this edit is set to warning, system will create this application as Master Account
and populate the Account # in Master Account # field.

Edit Name Default Type | Enabled
FOR MASTER ACCOUNT, LINK TO

MASTER ACCOUNT FIELD SHOULD Error N

BE BLANK

» Edit added to validate Master Account belongs to Customers Linked to the Current
Application or not.

Edit Name Default Type | Enabled

CURRENT AND MASTER ACCOUNT
SHOULD HAVE AT LEAST ONE Error N
COMMON CUSTOMER

> Edit added to validate Invalid Master Account #.

Edit Name Default Type | Enabled
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MASTER ACCOUNT # PROVIDED IN
LINK TO EXISTING MASTER Error N
ACCOUNT FIELD DOES NOT EXIST

Following edit added to validate Billing Cycle and Due day of current application with
Master Account Billing Cycle and Due Day if the current application is going be link to
Master Account.

Edit Name Default Type | Enabled

CURRENT AND MASTER ACCOUNT #
SHOULD HAVE SAME BILLING Warning N
CYCLE AND DUE DAY

- If the current application Billing cycle due day is not matching with Master
Account, system will fire the “Billing Cycle and Due day are not matching with
Master Account” edit.

- If current application is linked to existing Master Account and product is having
“Same billing cycle flag = Y” system will not validate the billing cycle and due day
based on same billing cycle flag, the precedence is given to Master Account
Billing cycle and Due day.

Following Contract Edit added to ensure Product Type of current application should

be same as the Master Account Product Type if the current application is going be

link to a Master Account.

Edit Name Default Type | Enabled
CURRENT AND MASTER ACCOUNT

SHOULD BELONG TO SAME Warning N
PRODUCT TYPE

- If the current application Product Type is not matching with Master Account,
system will fire the “Product Type not matching with Master Account” edit.

Edit added to validate Master Account and Associated Account are belongs to same

Company.

Edit Name Default Type | Enabled
CURRENT AND MASTER ACCOUNT

SHOULD BELONG TO THE SAME Error N
COMPANY

Servicing Changes

1. Following fields are added to Servicing > Account (s) table.
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Field Field LoV Mandatory

Name Type | Values | (Y/N) Comments

Populated same as Account # when a respective
Application is marked as Master Account at the
time of funding.

Master VARC Populated with provided Account # (Master

Account NA N Account #) if linked to an Existing Master Account
HAR ; .

# at the time of Funding.

If the Application neither marked as Master
Account nor linked to any existing Master Account
then this field will be blank.

New account level flag propagated from

Origination.
Master Check NA v g

Account | Box Display the Master Account indicator next to the
Master Account # in Account (s) table.

ORACLE T

Financial Services Lending and Leasing

‘Customer Service x

Search  Customer Service: LINE-MASTER-177 | Review Request (Pending: 0) | Queue Assignment

Account(s): LINE-MASTER-177: TESTING ASD
View v Format v [ Freeze B! Detach Wrap m & ® Current () Show Al ) Group Follow-up 581

Company Branch Sub Unit Account # Master Account #  Master Account | Product Billing Cycle Purpose Days Past Due Currency
uso1 USHQ UNDEFINED LINE-MASTER-177 | LINE-MASTER-177 Y LINE UNSECURED (VR) MONTHLY -28 USD

2. Above two fields are part of
e Queue Parameters
e Condition Criteria Parameters
e Correspondence Elements

3. A new “Statement Consolidation” flag is added at Servicing >Account Details and Servicing
>Account details >Contract information >Contract.

: Field LoV Mandatory(
Field Name Type Values YIN) Comments
Statement Read NA y Propagated from Origination >
Consolidation | Only Contract (2).
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Servicing >Account detail

s >Contract information >Contract

Custnmer Servier ;. Orignatien % || Trassaction Codes % [ Gose
Contract = Fepsyment [emaabioes  Trade-dn  Insurances ESC  Compemssbion  Subvesbion | Proteeds Dusbursements Fees  ACH  Coupon  POC  Heferences  Redl Cstate i
Contract Details [E e
view = Formet= [ snce [ cetach Wiap 7]
Lote Charge GrBCe i e e paund allaied Hafund ToleraNCe o yoluranc ame Pt Torance v PYOMISE Tolerance  Promise Tokrance  WinteOFf Tolersnce Mac Dut Dy Dus Day Min
v Aot il % Amt Change Days
[ ] 1] &Y L 1500 A5.00 (7] f.a0 L1 15 i Kl
. v
Contract Details
A Betum
* WrteOff Tolerance Amt  5.00
Belinquency
Account Information
£aRetun
Interest and Accruals # of Extension Term (vear) 0 Recourse Amt 0.00
# of Extension Tem (Life) 0
Accrual Start Ot 12/01/2018 # of Due Day Changes (Year) 0 Cure Letter
Last Accruzl Dt 12/01/2018 # of Due Day Changes (Life) 0
Stop Accrual Last Extn Dt Start Date
Accrual Method INTEREST BEARING Due Day Change D Expiry Date
Base Method ACTUAL/360 .
Rebate Methed NONE Additional Details Amortized Loans
Accrued Interest 78,59 Cutrs Principa Paié 0.00
Index Type FLAT RATE Total Term 12 e PrinciparFaie 8
Index Rate 0.00 Pad Term 0 Others
Margin Rate 4.99 Maturity Dt 12/01/2019 -
Rate 4.99 Balloon Amt 0.00 Statement Consolidation ¥
Rate Start of the Year 4.99 ‘Stmt Preference Mode
Last Rate Adj Dt ; Time Zone
# of Rate Adjs (Year) 0 Advance Details
# of Rate Adjs (Lifg) 0 Approved Amt_ 0.00 Time Bar Details
Beschedule Method |INDFETNED

[
Master Account.

If this flag is set to “Y”, this associated account will added to Statement Consolidation at

4. A new Master Accounts sub tab is added under Servicing >Customer Credit Limit >Customer

/ Business >Credit Limit
[

Following fields add

Details section.

ed to Master Account Detail’s table.

This tab will be access controlled.

Field Name

Field Type Comments

Account #

Read Only

Title

Read Only

Relation

Read Only

This field is not applicable for Business

Product

Read Only

Currency

Read Only

Billing cycle

Read Only

Delg Days

Read Only

Pay Off Amount

Read Only

Amount Due

Read Only
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Field Name Field Type Comments
Oldest Due Dt Read Only

Status Read Only

Asset Type Read Only

Asset Sub Type | Read Only

Collateral Read Only

Description

Identification # | Read Only

Company Read Only

Branch Read Only

The “Associated Account Details” table is added under Customer Credit Limit

>Customer/Business >Master Account Sub tab.

>

>

This “Associated Account Details” table will show the accounts where Account(s) >
Master Account # is equal to selected Master Account # at Master Account details

header level.

Following fields are available in “Accounts” table

Field Name Field Type Comments
Account # Read Only
Title Read Only
Read Only This field is not applicable for
Relation Business
Product Read Only
Currency Read Only
Billing cycle Read Only
Delq Days Read Only
Pay Off Amount Read Only
Amount Due Read Only
Oldest Due Dt Read Only
Status Read Only
Asset Type Read Only
Asset Sub Type Read Only
2-13
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Collateral Description

Read Only

Identification # Read Only
Company Read Only
Branch Read Only

e Displays the Primary Collateral Description and Identification #.
> No Collateral Description shown for Home Collateral.
e A hyperlink added on “Account #” which will open the respective account in servicing.

e |If user is does not have access to Servicing, system shows an error message saying “No
access available”.

e “Total Pay off Amt” and “Total Amt Due” field shown bottom of the Accounts table, which
includes the Associated Account’s and Master Account Dues and Payoff Amounts.

> This table shows the accounts having same currency as Master Account.

e A new Show All radio button added to show all the associated accounts with Master
Account irrespective of Currency. In this case, no “Total Pay off Amt” and “Total Amt
Due” fields displayed.

> Default value of radio button is ‘N’.

e A“Count” field added at the bottom of the table to display the total number of records
displaying in Associated Account Detalils table.

,,,,,,,,,

5. The new “Associated Accounts” tab is added under servicing >Account(s) which will display

the Associated Account to Master Account. (Account level Master Account # = Master
Account #).

x  Cuntomer Service

4| Cumtomar Semvice 10L0ITIZ

Acceuntislz F01901000147A2: TEST MASTER CONS. VIEW ANK ] [
B WG Poeeoo e

o ny
Lo vERprE (e Ry

mNRITE BN ¥

e Following fields are available in “Associated Accounts” table.

Field Name Field Type | Comments
Account # Read Only
2-14 ORACLE

Financial Services



Field Name Field Type | Comments
Title Read Only
Product Read Only
Currency Read Only
Billing cycle Read Only
Delq Days Read Only
Pay Off Amount Read Only
Amount Due Read Only
Oldest Due Dt Read Only
Status Read Only
Asset Type Read Only
Asset Sub Type Read Only
Collateral Description Read Only
Identification # Read Only
Company Read Only
Branch Read Only

e Displays the Primary Collateral Description and Identification #.
> No Collateral Description shown for Home Collateral.
e A hyperlink added on “Account #” which will open the respective account in servicing.

e If user is not having the access to Servicing, system will show an error message saying
“No access available”.

e “Total Pay off Amt” and “Total Amt Due” field shown bottom of the Accounts table, which
should include the Associated Account’s and Master Account Dues and Payoff Amounts.

» This table shows the accounts having same currency as Master Account.

e A new Show All radio button added to show all the associated accounts with Master
Account irrespective of Currency. In this case, no “Total Pay off Amt” and “Total Amt
Due” fields displayed.

> Default value of radio button is ‘N’.

e A“Count” field added at the bottom of the table to display the total number of records
displayed in Associated Account Details table.

A new non-monetary transaction added to update “Statement Consolidation” flag at Servicing
>Account Details.
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Syste
m
Defin State
ed Txn/ | ment State
Descrip Acti | Monet | Yes/ | Enab | Bal TN Bat | Man | ment G
tion Group | on ary No led Type | Type ch ual Print L
STATE
MENT
CONSO
LIDATIO
N FLAG
MAINTE | Accou | POS NON
NANCE | nts T N No N E NONE | N Y N N
e Following are the Transaction parameters.
LOV .
Parameter Paramete Value Default | Displaye | Mandator Comments
Name r Type S Values | d (Y/N) y(Y/N)
TXN DATE Date NA g;;?;em Y Y Transaction posted date
STATEMEN
1(;ONSOLID LOV YES NO v v To updgte the flag based
ATION NO on provided value
INDICATOR
To define whether the
Process .
Master YES transaction expected to
. LOV NO Y Y post at Current Account
Associated NO «
ACCOUNtS or quter Account and
Associated Accounts”.
If the Parameter set to
Y, post this transaction
to Associated Accounts
PROCESS where the Product Type
SAME is equal to Current
PRODUCT YES Account Product Type
TYPEAND | LOV NO Y Y where this transaction
FUNDING NO posted.
TYPE
ACCOUNTS If the Parameter set to
N, Post to all the
Accounts under a
Master Account.
REASON Reason code for posting
CODE LOV NA NA Y N this transaction.
COMMENT Text Box NA NA v N Provide if any related
S comments
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e This transaction update the current filed in Account Details >Other > Exclude Statement

Consolidation.

7. A new non-monetary transaction “MASTER ACCOUNT MAINTENANCE" added to link an
account to an existing Master Account, or to move from one Master Account to other or to
remove from a Master Account. This transaction allowed to post from Servicing >Account
>Customer Service >Maintenance.

Syst

em

Defi Txn/ | State

ned Bal ment Ma | State
Descriptio Act | Mon | Yes/ | Ena | Typ | Txn Ba | nua | ment
n Group ion | etary | No bled | e Type | tch || Print | GL
MASTER
ACCOUNT
MAINTENA PO NON | NON
NCE Accounts | ST | N No N E E N Y N N

e Following are the Transaction parameters when the transaction posted from Account.

Parame | Parame e Display | Mandat
LOV ult
ter ter values | Valu ed ory(Y/N | Comments
Name Type es (Y/N) )
Syst
Date Date NA em Y Y Transaction posted date
Date
Which account need to be
attached/Move/Remove to/from new
Master Account.
Account | Text This field only allow the accounts
NA NA Y Y where the selected customer linked.
Number | Box
If there is an invalid account number,
system shows an error message
saying “Invalid Account #” and not
allowed to post the transaction.
This filed have the Master Account #
to which the current account is going
Master | o to mapped or removed.
Account Bf)); NA NA 1Y Y If there is an invalid Master Account
Number #, system shows an error message
saying “Invalid Master Account #” and
not allowed to post the transaction.
ADD /
Mainten UPDA To decide whether to
ance LOV TE/ ADD |Y Y ADD/UPDATE/REMOVE a Master
Type REMO Account.
VE
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Parame | Parame bt Display | Mandat
LOV ult
ter ter ed ory(Y/N | Comments
Values | Valu
Name Type es (Y/N) )
This field is to define whether the
}l_/éLIDA common customer between the
COMM account and Master Account
validated or not.
ON
CUSTO If the Parameter = Y and if there is no
MER common customer between Account
BETWE | Check and Master Account, system shows
NA Y Y Y “
EN Box an error message “No Common
ACCOU Customer found” and not allowed to
NT AND post the transaction.
:\QAASTE If this parameter = N and is there are
no customer exists between Account
ACCOU ) X
and Master Account still system will
NT ; :
allow to post this transaction.
This field is to define whether the
}l_/éLIDA same Billing Cycle and Due Day
BILLIN between the Account and Master
G Contract validated or not.
CYCLE If the Parameter = Y and if the Billing
AND Cycle and Due Day of the Account is
DUE different from Master Account Billing
DATE Check NA v v v Cycle and Due Day, system shows
BETWE | Box an error message “Billing Cycle and
EN Due day are not matching with
ACCOU Master Account” and not allowed to
NT AND post the transaction.
EAASTE If this parameter = N and if the Billing
Cycle and Due Day is different still
ACCOU .
system will allow to post the
NT :
transaction.
Master Account provided in
¥éLIDA transaction parameters and the
Account where this transaction
PORTF
OLIO posted are belongs to same
COMPA Company or not.
NY If the Parameter set to Y, system
BETWE | Check NA v v v validate if the Master Account and
EN Box Account where this transaction
ACCOU posted are belongs to different
NT AND company and show an error message
MASTE saying “Company mismatch”.
R If the Parameter set to N, system will
ACCOU . ;
NT not validate the company is same or
not.
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Defa

Parame | Parame LOV ult Display | Mandat
ter ter ed ory(Y/N | Comments
Values | Valu
Name Type es (Y/N) )
To define whether the transaction to
Process be posted at Current Account or
Master Yes “Master Account and Associated
:[A\SdSOCIa LOV No % % Accounts”.
e
Account No Txns appear in BMT (both monetary
s and non-monetary) as well as in Txn
history (only monetary).
PROCE
SS
SAME If Parameter set to Y, post this
PRODU transaction to Associated Accounts
CT Ves where the Product Type is equal to
TYPE | 5y No |V v Current Account Product Type where
AND No this transaction posted.
FUNDI
NG If Parameter set to N, Post to all the
TYPE Accounts under a Master Account.
ACCOU
NTS
Reason | LOV NA NA v N Reason .code for posting this
transaction.
Etomme 'El;(e);((t NA NA Y N Provide if any related comments

e |f the above transaction posted from current Account, Validate Account # parameter
should be same as Current Account #.

e If the above transaction posted from Master Account, Validate Master Account #
parameter should be same as Master Account #.

e For Add, if Master Account # <> UNDEFINED, Error message “ACCOUNT IS ALREADY
LINKED WITH ANOTHER MASTER ACCOUNT".

Once this transaction posted successfully, system update the Master Account # in
Account level Master Account field.

Comment posted on all involved accounts i.e. Master Account and Associated

Account.

e For Remove, if Master Account # = UNDEFINED, Error message “ACCOUNT IS NOT

LINKED TO GIVEN MASTER ACCOUNT".

Comment posted on all involved accounts i.e. Master Account and Associated

Accounts.

e For Update, Overwrite the master account number of current account with Master
Account # provided in Transaction Parameters.

Comment posted on all involved accounts i.e. Master Account and Associated

Accounts.

e |If the transaction posting fails in any one of the account the transaction will be roll back
from all the accounts and shows an error message “Transaction failed to post in
<<Account #>> and shouldn’t allow to post this transaction.
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Note: In case of replacing a primary customer due to deceased primary customer, user is
expected to move the accounts under decease customer >Master Account to new customer
Master Accounts manually.

8. Handling of “MULTIPLE ACCOUNTS EXIST" condition:
e This condition open/close in all of following scenarios:

> When account created using Origination Funding, Account Boarding WS,
APIl/Conversion Process and results in more than 1 associated account under a
Master Account, then system opens this Condition on Master Account.

>  When “MASTER ACCOUNT MAINTENANCE” txn posted which resulted in either
adding more account under Master Account due to Add/Update or reduced accounts
due to Remove and result in more than one account under a Master Account then
Open this Condition on Master Account.
- If Results in Less than or Equal to One Associated Account Remove the

Condition.

Web Services

1. Existing Account Onboarding Service enhanced to support creating the Master Account and
Associated accounts using single payload.

e Following fields added to Existing Account Onboarding Web Service.

WS Field LOV Mandat

Field Name Element Type Values | ory(Y/N)

Comments

MasterAcco At Associate Accounts, This
untNumber filed indicates which Master
Account this Associated
Account linked.

If a Master Account and their
Associate Accounts are going
Master VARCH | \ A N to be created with a single
Account # AR payload and the AUTO
GENERATE ACCOUNT
NUMBER FOR CONVERSION
PROCESS= N, this filed
indicates, Associated Accounts
are going to be linked to which
Master Account.

MasterAcco At Associate Accounts, This
untXrefNum filed indicates which Master

ber Account Xref this Associated
Account linked.

If a Master Account and their
Associate Accounts are going
Master VARCH | \ A N to be created with a single
Account Xref # AR payload and the AUTO
GENERATE ACCOUNT
NUMBER FOR CONVERSION
PROCESS =Y, this filed
indicates, Associated Accounts
are going to be linked to which
Master Account.
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Field Name WS Field LoV Mandat Comments
Element Type Values | ory(Y/N)
MasterAcco Flag to Indicate
Master untindicator Check NA Y Application/Account as Master
Account Box
Account.
StatementC Flag to Indicate whether the
Statement onsolidateln | Check NA v Associated Account Statement
Consolidation dicator Box allowed to Consolidated at
Master Account or Not.

If a Master account linked to more than one account as part this service, system posts a
condition “MULTIPLE ACCOUNTS EXISTS” on Master Account.

If the Master Account indicator provided for an account then system should create that
account as master account. Here the Existing Master Account number is not required.

Existing Account Onboarding validations should be applicable to this web service

Assumptions:

Above services are able to onboard all product types [Loan, Line and Lease]
Above service are able to onboard with all product combinations.
> Ex: Onboard Master Account as a Line of credit
10 Loan Accounts with Vehicle Collateral
5 Lease Accounts with Other Collateral
5 Line Accounts with Unsecured
> Above services onboard all Collateral Types [Vehicle, Home and Other]

2. Existing Get Account Details web services enhanced to get the Master Account and
Associated Account details by sending the Master Account # and Display Associated
Accounts fields as request parameters.

Request Get Account Details Service:

Account #
Display Associated Accounts (Optional)

If the Account # given as part of request Parameter, system will give the respective
account details as part of response.

If the user provides Account # and Display Associated Accounts flag = Y as part of
request, System checks if the provided Account is Master Account,

> If yes, Respective Master Account Details and all the Associated Account details
provided as part of response.

> If No, System shows an error message “Provided Account # is not a Master
Account”.

If the Account # and Display Associated Account flag = N is given as part of request
Parameters, system will give the respective account details.

Consolidate Master Account Statement

1. New radio buttons ‘Current’ and ‘Consolidated’ are available only in Master Account to view
statements of current Master Account and consolidated Statements of Master Account and
Associated Accounts.
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e On selection of “Consolidated” radio button, System displays a table called Consolidated
Statement Details. This is similar to existing Statement details with consolidation of
statements associated with Master Account.

> “Loan, Line and Lease” radio buttons added to group the consolidated statements
based on Product/Funding type.

> The default Product type is Master Account Product type.
> The table fields are similar to existing statement fields of Loan Line and Lease.

o |If the User selects Current Radio button, system hide the Consolidated Statement Details
table and the Account # field from Statement, Transactions, Messages and Usage
Summary.(As Is)

e Consolidation Statement details table should include associated accounts where the
“Statement Consolidation flag = Y” along with Master Account Statement.

e Anew Account filed added in Statement, Transactions and Messages.

e System excludes the Associated Accounts that belongs to different currency other than
Master Account.

Customer Service » 3] Close
Summany ol 1 ored 3
Account Detals  Slatements  Rate Schedule  Insurances
L Nest Account
4 ji Fltered hucount
Statemenls (5] view || s Audit e
W mat ~  EF ere [ Detach Wrap ] Add Comment
Beepe  Generates ot ® Mert
Type REGULAR
Penduet Type (W) Loan (01 Lease O Line
1 I Consul Statement Delails I (5} view
i - Freeze |} Detach Wras "]
FastDue  Late Charge {#]  Other Charges(+) New Balance = Currer: Balance Pay OF Dt Fay Off ame Escrow Cor Balance Esen
3 i Pest comment t | | g Clear
Add Call Activity
Statements | Transactions  Messages | Usige Summary
Stalement Delails [E] views || o sudn
wiew » Format~ [P Fre B vetack ]
Currest Duel+) PastOue  Late Charge (+)  Oither Charges(s) Hew Balance = Current Balance Py OFF Dt Pary OFF Amt :_::_
= Condition

e A new batch job “MASTER ACCOUNT STATEMENTS GENERATION” added in batch
job set “SET-ODD2” to generate consolidated Master Account statements.
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> Following are

Reference 1: master _customer_statement

the sample file formats:

20170404.txt

Reference 2: statement.xlsx

CORACLE’

Financial Services Lending and Leasing

AOA = ag signput O

Data Files
Output | Ingut
Dala File Definitivns
iew =

4

Name
MASTER_CLSTOMER_STATEMENT

Format =

Record Delinitions

wiew = Format = [ Freeze  poll Detach
Record Type Descripbon
[ HEADER RECOED

MASTER ACLDUNT RECORD
LINKED ACCOUNT RECORD
ASSLT DETAILS #LCORD
TRANSACTION RECORD
MESSAGE RECORD:
FOOTER RECCRD

Column Definitions
view v Format+ 5 reeze [ Detach
Seq Caluma Hame
o 1 RECORD TYFE
2 STATEMENT DATE

Fie Name Dhrectory Path System Defned Yes/Me  Lnsbled
master_rastomer_statement_{PROCE  LINDEFINED Yés W Mo ¥
dradd || Sed | [Fvew o ande
a L]
Record Format Deheniter Termunator
WARIABLE ] CARRIAGE RETURN AND LINE FEED
WARIADLL I CARRIAGE RETURN AND LINC FELD
VARIABLE | CARRIAGE RETURN AND LINE FEED
VARIAULE I
VARIABLE |
VARIABLE I
VARIABLE |
dpadd || FEa | [ view o Aeat
Data Type Frirmat Mask Length Data Celumn Outpt Colume
VARCHARD NOT APPLICAILE Jo 1 1
DaTE MHTIDAYYY 1 2 2
VARCHARZ NOT APPLICADLL o 3 3
VARCHARD NOT APPLICABLE a0 + £

dadd || oo | D view

o medt

Ho

Copynght & 1558, 2015, Orace andlor its affiiates. AN rights reserved

About

CUSTOMER STATEMENT TRANSACTIONS Enhancement:

2. “Master Account #” filed is added to existing “CUSTOMER STATEMENT TRANSACTIONS” report

input parameters.

Parameter Name

Parameter Type | Comments

Master Account #

Text Filed

Master Account #’s linked to Customer #

> If user provides only Customer #, System will generate the report with accounts

associated with the customer (Existing feature).
If user provides the Customer # and Master Account # combination, system will

\%

generate the report with the accounts, which are in that combination.

\%

Master Account # field added to Report Header along with Customer #.

Date From:

Customer #:

05/05/2011 To:

Report : Customer Statements Transactions Report

Date: 5/6/2019 7:32 AM

05/05/2019

678678767

I Master Account #-:

LINE-MASTER-194 |

Company Name :

Branch Name:

DEMO BANEK USA

Us HEAD QUARTERS

oRrACLE
Financial Services Lending and Leasing

Account #: LINE-MASTER-194 Relation: PRIMARY ALL AMOUNT ARE IN USD
Txn DATE Txn Description Amount

12/11/2017 LATE CHARGE 30

11/11/2017 LATE CHARGE 30

10/11/2017 LATE CHARGE 30

09/11/2017 LATE CHARGE 30

os/11/2017 LATE CHARGE 30

07/11/2017 LATE CHARGE 30
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https://docs.oracle.com/cd/F16599_01/pdf/refdocs/ofsll_release_notes_attachments/master_customer_statement_20170404.txt
https://docs.oracle.com/cd/F16599_01/pdf/refdocs/ofsll_release_notes_attachments/statement.xlsx

Reports x  Reports x 2] Close

Reports deadd | [uew | o sl
wew « Format = 50 Freece [l Detach Wiag "]
s
é e o
code Dsscnghon Fackage 1ot System Defined  Enabled

CUSTOMER_STH_TRANSACTION IC\I’S'TOMB! STA NTS TRANSACTIONS I QCATXH_EM_100_01 SERVICING Yes = Mo ¥

'
Report Paramelers dradd | [Juew | o ade
View = Fomut+  EF -
Paramy eter Type Parameter Sub Type Default Sort Enatled
¥

Payment at Master Account level:

1. The “Master Account #” LOV is added to Payment Entry >Payments table after the Customer
# field.

Field Name Field Type | Mandatory(Y/N) | Comments

This field used to provide the Master

Master Account # | LOV N Account # linked to Customer #.

e A system parameter added to render the Master Account # in Servicing >Payment Entry.

> Even though the existing “CUSTOMER BASED PAYMENT = N” and the above
parameter is Y, system will render the “Payment Hierarchy” and “Populate Accounts”
fields.

> When user selects the Multi Account flag = Y, “Payment Hierarchy” and “Populate
Accounts” fields will be enabled (as its happening for Customer based payments).

e This LOV shows the Master Accounts associated with the customer selected in Customer
# field.

e If user provides “Customer #, Master Account # and Payment Hierarchy” values and click
on populate button, system first filters the accounts based on Customer # and Master
Account # and apply the payments based on payment hierarchy and populate the records
in Payment Txns block.

e If the customer # not selected, then system shows all the Master Account #'s belongs to
selected Company/Branch at Batch level.

e If the user selects only Master Account number then the Account # filed shows the
Accounts under selected Master Account in case of single payments.

o If user selects Multi Check box and provides only Master Account and Payment
Hierarchy values and click on populate Accounts button, system first filters the accounts
related Master Account # and apply the payments based on payment hierarchy, and
populate the records in Payment Txns block.

o If user provides only the Customer # and Payment hierarchy and click on “Populate
Accounts” button, system populates the accounts related to Customer # and apply the
payment based on payment hierarchy. (Existing Functionality).

e Same field should be available in Customer Based payments (Customer/Business) web
services as request parameter.

» Customer # or Master Account # is mandatory.
> Rest of the existing validation are As Is.
e Same field added to Customer Based Payments (Customer/Business) file upload.
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» Customer # or Master Account # is mandatory.

» If the Customer # field provided then only “Customer Type” filed validated.

> Rest of the existing validation should be As Is.
Reference: CustomerBasedPayments.xls

e This field added to customer based payments child section along with Customer #.

Payments

Payment Lntry  Payment

Batch

Wiew Dotions

View = Foemat = -4
Compasy Branch
(] Al
ust1 AL

" Payments

Payment Txns
View v Format +

Areaunt = Tale
He data ta display.

nce  Sesrch

All Payments

Fronce [ Betach

Batch £

B 3 pelee

Fayment Hierarchy

3+ % | EQUAL AMDUNT

Date Batch Type

05/05/201%

Account =

PHT MANUAL

T MANUAL

splarys the Arceost Number

LinL-mazTR-194) ] TESTING ASD:

Amount Sprea

Balch Status

Account Status

ACTIVE:DELQ

Tokal & Clr| Tatal 2

I smveanc s I Save st Retan

Pt %

Seadd | gear | [Tview || o aude

Total Amt  Clel Tolal At
0000 0.0

£ Beturn

Cumency Pt Aot Soread

US DOLLA ¥ 0.00 ACTIVE SPR

Errar Rrasen

Transaction posting at Master Account level:

1. When following transactions posted at the Master Account level, Same Transaction posted in
all the accounts under the Master Account based on transaction parameter.

e The following parameter added to below transactions to define whether the transaction
needs to post at specific Master Account or Master Account and Associated Accounts.

Parameter | Paramet | LOV Default | Display | Mandatory

Comments
Name er Type | Values | Values | ed (Y/N) (Y/N)

To define whether
PROCESS the transaction
MASTER Yes posted at Current
ASSOCIAT | LOV No Y Y Account or “Master
ED No Account and
ACCOUNTS Associated

Accounts”.

To define whether to

Post this transaction

to Account which
PROCESS are having same
SAME product as Current
PRODUCT Yes Account where this
TYPE AND | LOV No % % transaction posted.
FUNDING No This parameter will
TYPE be considered only
ACCOUNTS when PROCESS

LINKED

ACCOUNTS

parameteris Y.

e DUE DATE CHANGE and DUE DATE CHANGE OVERRIDE.
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Result: [BEFORE]
Current Due Date = << Due Date>>
Next Due Date = << Due Date>>
[AFTER]
Current Due Date = << Due Date>>
Next Due Date = << Due Date>>
**xxx Transaction Posting Successful **x**
Error Message: <<Unable to post the transaction in <<Account #>> >>
ACH
> NEW ACH MAINTENANCE
> ACH ONE TIME PHONE PAY
> ACH STOP ALL ACCOUNT ACH
> ACH FEE MAINTENANCE
Result: ***** Transaction Posting Successful *****
Error Message: <<Unable to post the transaction in <<Account #>> >>
Extension
Result: ***** Transaction Posting Successful *****
Error Message: <<Unable to post the transaction in <<Account #>> >>
Extension Override
Result: ***** Transaction Posting Successful *****
Error Message: <<Unable to post the transaction in <<Account #>> >>
Payoff Quote
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Master Account 1 has 5 Accounts associated

Payoff Quote at MA1

Total Payoff Quote = <<Sum of 5 Accounts + Master Account Payoff Quote Amount>>
Master Account 1 Payoff Quote

<<Details>>

Account 1 Payoff Quote

<<Details>>

Account 2 Payoff Quote

<<Details>>

Account 3 Payoff Quote

<<Details>>

Account 4 Payoff Quote

<<Details>>

Account 5 Payoff Quote

<<Details>>

Error Message: <<Unable to post the transaction in <<Account #>> >>

> If the Payoff Quote Txn posted from non-master accounts with “Process Master
Associated Accounts” is set to Y, system shows an error message saying
“PROCESS MASTER ASSOCIATED ACCOUNTS and PROCESS SAME PRODUCT
TYPE AND FUNDING TYPE ACCOUNTS should be N” and should not allowed to
post the transaction.

>  If this transaction is posted from Master Account and “PROCESS MASTER
ASSOCIATED ACCOUNTS =Y, system posts this transaction in accounts which are
having the same currency as Master Account.

> If this transaction is posted from Master Account and “PROCESS MASTER
ASSOCIATED ACCOUNTS =Y and PROCESS SAME PRODUCT TYPE AND
FUNDING TYPE ACCOUNTS = Y”, system posts this transaction in accounts which
are having the same currency as Master Account.

- If the transaction failed to post in any one of the account, system reverts from all
the accounts and show the error message in Result block of account where the
transaction posted.

Error Message: <<Unable to post the transaction in <<Account #>> >>
>  All existing validations should be applicable for above transactions.

2.1.2 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.2

221

2.2.2

Business only Account

Overview

Previously, OFSLL enforces to add Primary Applicant along with the Business/SME. After this
release, user can able to create the Business only account i.e., user can create the account
without any individual customer and service using the business details.

Description

Setup > Product > Contract > Iltemizations

‘CUSTOMER'’ lookup in DISBURSEMENT_TYPE LOV renamed as ‘Customer /
Business’ because of same contract can be used for Business or Customer.

If product is ‘Direct’, and If application/account is business only, then AP will create with
business details

While running the credit refund batch job, system will create the AP transaction with
business details for business only account

Customer Service > Customer Service > Correspondence / Letters

Provided the new Lookup under CORR_MULTI_RECIPIENT_TYPE_CD, as ‘Business’

for setting up the business correspondences

>  While user generating the Correspondence from the ‘Correspondence’ tab, if
Business details were not there then system shows an error.

> If the Recipient is business only and business Stop Correspondence is Y’, then
system shows an error.

Provided the new Lookup under RECIPIENT_TYPE_CD as ‘Business’

>  While selecting the recipient as ‘Business’ under ‘Correspondence > Recipient
Details’ and ‘Letters > Recipient Details’, system will enable the Mode and Type
fields and if user selects the mode and type as eMail, then system will populate the
email id from the business detalils.

> If Stop Correspondence flag enabled, then system should will show an error on click
of send button.

Note: Batch jobs that generates the letters are not part of this release. User can generate the
letters for business only account manually, view it on screen and send from UlI.

Customer Service > Customer Details > Business

Provided a new lookup value under the APP_CLASS_TYPE_CD as ‘BUSINESS ONLY’
to differentiate the business only account

System will disable the ‘Customer Details > Customer’ tab and renames the ‘Customers
Details’ tab with ‘Business Details’ tab.

On click of Add/Edit following fields are available for modification, except ‘Bankruptcy’
and ‘Update Business Info’
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Description Input/ Object | Mandatory | Data | Field Def | Comm
Selectable/ | Type Y/N Type/ | Valida | ault | ents
Display Size | tion Val
Only ues
Stop Correspondence | Selectable | Check |Y Varch N
. Box ar
Skip
Bankruptcy
Privacy Opt Out
Insurance Opt Out
Marketing Opt Out
Share Credit opt Out
Update Business Info | Selectable | Check | N Varch N
Box ar
Email Input Text N Varch | Existin | Null
ar g
Email
check

Customer Service > Customer Details > Business > Address

e On click of Add/Edit following fields are available for modification, except ‘Time Zone’;

e Populate Time zone from the Business Details, and propagate from the Account on-
boarding service.

Descriptio | Input/ Objec | Mandator | Data Field Defau | Comment
n Selectabl |t y YIN Type/ | Validation It S
el Type Size Value
Display s
Only
Confirmed | Selectabl | Chec |Y Varch N
- e k Box ar
Mailing
Time Zone | Selectabl | LOV N Varch | TIME_ZONE_ | Looku
e ar CD
Defaul
t

Customer Service > Customer Details > Business > Telecom

e While user adding a new telecom, each time system will validate there is only one current
record exist. i.e., if new telecom been added with current, then if any record exist with the
same type, change the previous records’ current indicator as ‘N’ and save the new
telecom as ‘Y’

e On click of Add/Edit these fields will be available for selection
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Descripti | Input/ Obje | Mandato | Data | Field Validation Defau | Commen
on Selectabl | ct ry Y/IN Typ It ts
e/ Type e/ Value
Display Size S
Only
Time Selectabl | LOV | N LOV | TIME_ZONE_CD Null
Zone e
Best Day | Selectabl | LOV | N LOV | CALENDAR_DAYS | Null
to Call e _CD
Start Time | Input Text | N Tim | 24 hr time Null
e
Period Selectabl | LOV | N LOV | TIME_PERIOD_CD | Null
e
End Time | Input Text | N Tim | 24 hr time Null
e
Period Selectabl | LOV | N LOV | TIME_PERIOD_CD | Null
e

Servicing = AP Transactions

e Added new ‘Business’ radio button under ‘Payee Type’

o If any payable transactions that created for business system will create the AP
transaction and populates he Payee Name with ‘Business Name’ and Address details
with ‘Business Address Details’ for business only account.

Customer Service > Maintenance

e Following new transactions made available for Business Only and SBL Accounts

Txn Code Txn Description

Txn Parameters

BUS_BANKRUPT
CY_INFO

BUSINESS BANKRUPTCY
REPORTING INDICATOR

BANKRUPTCY INDICATOR
BANKRUPTCY DISPOSITION
BANKRUPTCY TYPE
EFFECTIVE DATE

BUS_CON_ADR_

MAINT CONFIRMATION

BUSINESS ADDRESS

TXN DATE
CONFIRMED ADDRESS INDICATOR
BUA ADDRESS TYPE CODE

BUS_NAME_MAI | BUSINESS NAME
NT MAINTENANCE

TXN DATE
BUSINESS NAME
BUSINESS LEGAL NAME

BUS_PH_MAINT | BUSINESS PHONE

MAINTENANCE

TXN DATE
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Txn Code

Txn Description

Txn Parameters

BUA PHONE
BUA ADDRESS TYPE CODE
PERMISSION TO CALL IND

BUS_PRIVACY _|
NFO

PREFERENCES

BUSINESS OPT-OUT

(PRIVACY OPT-OUT)

TXN DATE

PRIVACY OPTOUT
INSURANCE OPTOUT
SHARE CREDIT OPTOUT
MARKETING OPTOUT

BUS_SKIP_MAIN
7

BUSINESS SKIP

TXN DATE
BUSINESS SKIP INDICATOR

BUS_STOP_COR
R_MAINT

BUSINESS STOP

CORRESPONDENCE

TXN DATE
BUSINESS STOP CORR INDICATOR

e Added new p

arameters to the following existing non-monetary transactions

Txn Code

Txn Description

Txn Parameters

BUS_TEL_MAINT

MAINTENANCE

BUSINESS TELECOM

BEST CALL START TIME
BEST CALL START TIME PERIOD

BUS_NEW_TEL

ADD BUSINESS
TELECOM

BEST CALL END TIME

BEST CALL END TIME PERIOD
TELECOM TIME ZONE

BEST DAY TO CALL

BUS_ADD_MAINT

NEW BUSINESS
MAINTENANCE

BUSINESS TIME ZONE

BUSINESS SKIP INDICATOR
BUSINESS STOP CORR INDICATOR
BUSINESS ENABLED INDICATOR
PRIVACY OPTOUT

BUSINESS EMAIL ADDRESS1

BUS_MAINT

BUSINESS
MAINTENANCE

BUSINESS TIME ZONE
REASON CODE

Servicing > Batch Transactions > Payments > Payment Entry

¢ Renamed, Customer # with ‘Customer / Business #’

Customer Service > Bureau

e Disabling this tab for business only account
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System Monitor > Batch Job

e While running the below batch jobs, system will refer the Business Details for business
only account

> SET-PRQ > PCUPRC_BJ 100 01 > CUSTOMER REFUND PAYMENT
REQUISITIONS

e If the business only account having the credit balance and while running this batch job,
system will create the AP transaction with the business details

> SET-IFP > ICPPRC_BJ_100_01 > CUSTOMER PAYMENT FILE UPLOAD

o If the payment uploads happening with business details and those accounts are business
only account, system will process the payments

> SET-LTR2>LCSSTM _BJ 100 01 > CUSTOMER STATEMENT LETTER
e System will generate the statement using the business details
> SET-ODD2 > OSTPRC_BJ_100_01 > CUSTOMER STATEMENTS GENERATION

e While running the Archival and Purging, batch jobs system will process the business only
and accounts

Account Conversion

e System will convert the business only account with new fields added in the business,
telecom and address

Note: Displaying in the Ul (conversion screen) is out of scope for this release.

Web services

e Account Search Get WS
> Added new request parameters to the service
- Name of the Business
- Legal Name
- Tax ID#
- Business Phone
- Business Number
e Added following new elements to the response
> Business Number
> Name of the Business
> Business Email Address
> Business Legal Name
> ClassType
> Businessind

 New fields added in the business, and telecom also added in the following services
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Account On-boarding

Created a new Lookup value under ‘APP_CLASS _TYPE_CD’ as ‘Business Only’
If user pass this value then, system will treat that account is Business only

Account Details

As part of the response, system will pass the new elements/blocks as part of the

response
Also, sharing the securitization results and conditions.

2.2.3 Screen Changes

Customer Service > Customer Service > Correspondence / Letters > Recipient Details

Recipient Details g add | P Edt | S view | 2 Audit
view v Format~ [ Freeze EfiDetach | ol Wrap G [send
Recipient Mode Type FAX fEmail Sent Indicator Comments
N
Recipient Details
E Save and Add E Save and Stay E Save and Return (; Return
* Redpient BUSINESS ~ *Type EMAIL ~ Comments
* Mode EMAIL - FAX/Email PAVAN@YMAILL.COM
Customer Service > Customer Service > Customer / Business Details
Summary | Collections = Customer Service = Account Detawlsl Business Details | Customer Preferences ~ Transaction History =~ PmtModes  Bankruptcy  Repo/Foredosure  Defidency  Collaterz » ™
Business
Business Details
o Add || Edit view || o Audit
View v Format~ [ Freeze it Detach ¢l Wrap 8 show sl O
Current Business # Organization Type  Type of Business Business Category  Mame of the Business Legal Mame TaxID #
¥ 0000002061 CCORP SERVICE stri23 stri23 xxxx5119
< >
Addresses | Telecoms Partners  Affliates = Tracking Attributes | Business Score
Customer Service > Customer Service > Customer / Business Details > Edit
Business Details
A save andstay | [ save andRetun | <gRetun
Business ¥ 0000002061 * Management Since | 123 Total Utiized Amt 0,00
* Organization Type | C CORP i Payment Hierarchy EQUAL AMOUNT - Avaleble At 0.00
. Hold Amt 0,00
Type of Business  SERVICE ~ * Stop Correspondence ||
« 50 O Suspended Amt 0,00
Business Category P Grade
* Name of the Business | STR123 Bankruptcy Mas Lste Charge 0,00
+
*+egal Name | STR123 . Prvacy 2”: 2”: g Limit Expiry  12/31/4000
nspurance Opt Ou
+ oo Limit Next Renewal  12/31/4000
*TaxID ¥ XHOX5119 * Mrketing Gpt out [
*swtot 1213012 B * Share Credit Opt Out (] Utilization Details
* # of Employees(Cur) 123 Update Business Info __
= # of Employees 123 Email % of Utlization 0,00
Utilization Amount 0
Contact Person | STR123 o _
Credit Limit Details
* Business Checking Bark STR123
* Bark Acc £ | 123 Max Limit 0.00
* Avg Checking Balance | 123,00
* #of Locations | 123
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Customer Service > Customer Details > Business > Address

Address Information
D sove ond Sty || B Sove nd Retun || Gaetuan
= Current @ Street Fre | EAST r * Zip 00603 x
- Pﬁnfii?im to Call @ Strest Name | RAY ROAD Tip Extn
* Permission to Text Street Type | ALLEY ALY ' * ity RAMEY
Streat Post | NORTH v * State | PUERTO RICO ’
Apt® 1405 { -000-0000
Adkkess Type WORK v Phone | {000)-000
Address 1| BKC E RAY ROAD ALY N 2 1405 /
* Country  UNITED STATES v - e -
A = . Addeess Line 2 Tirne Zooe |
NORMAL ADOR Comment
Address & BKC

Customer Service > Customer Details > Business > Telecom

Telecom Information

* Parmission to Call Tirme Zone v
* Permission to Test & Best Day to Call ¥
* Tedocom Type | PHONE X Start Time
Phone | (915)-484-5545 Period v
Extn 12 End Time
* Current 8 Period v

Servicing > AP Transactions

AP Transactions 3 Close

Requisitions
e || [y | o e

Pavee Tvpe Pmt Mode Status
® All () Producer () Third Party €1 Vendor () customed[ Bushess | ® Al A ) Check ® A8 () Open (0 Close () Hold ) vold
Vaw = Fomat = [ Frecze [ Detach o wio B Viewlst @1Day O 1 Week O 1 Morth O By Date  Start Dt Erd Dt E]

Rioqpisition 14 Conrgeny Brarch Transartion Dt Stahis Sub Stabus Sub Qs Dt Paryes Tirur Paryesr Curtoncy Amenink
a7 st sy o425/ 2019 oPEN READY ' : 00002 so! 12,000.00
2z usol USHO 130/2019 OBEN READY PRODUCER CA-GO002-RANDYS AUTD 54, LSO 50,000.00
] us0L usiy 2019 oPEN REALY CUSTOMER 0180100021746 NAVEEN C.. IS 15,000.00
QT usoy USHQ 30/2009 OPEN READY 1RD) FARTY - uso 10,000.00
04 usoy USHG 04/30/2019 OPEN READY 'OMER. 2010050002021 8-NAPHADE ... USD 15,000.00
iz usoy USHG 1425/ 2019 OPEN REALY THIRD FARTY uso 15,000.00

L] »

2.2.4 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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Customer Credit Limit Phase |l

Overview

This enhancement is to provide Customer Credit Limit Expiry Date validations to the transactions,
which result in Maturity Date Change. This will ensure the Maturity date of an account should be
less than or equal to Customer Credit Limit Expiry in case of Maturity date changes.

Provided the Customer Credit Limit related fields in Correspondence elements, this will enable
user to create customer credit limit related Correspondence.

Customer Credit Limit Expiry Date Validation

1. When user tries to post any Transaction which will result in Account Maturity Date Change,
validate if the Maturity date resulted from transaction is greater than the “Customer Credit
Limit Expiry date” of any one of the customer who contributed to funding the Account and
shown an error saying “<<Transaction Description>> not allowed as Maturity date is greater
than Customer Credit Limit Expiry date” and don’t allow to post the transaction

Example Transactions:

2. Above validation is also be available for following functionalities.

Extension

Extension Override
Reschedule

Due Date Change
Change Payment Amount

Generic Transaction post web service.
Transaction Upload File.

Following Customer Credit Limit Details are part of

Queue Parameters
Condition Posting Criteria Parameters
Setup > Correspondence > Elements

Field Name Data Type
Relation Type VARCHAR
Customer # / Business # VARCHAR
First Name VARCHAR
Middle Name VARCHAR
Last Name VARCHAR
Max Limit NUMBER
Total Utilized Amt NUMBER
Available Amt NUMBER
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Field Name Data Type
Hold Amt Number
Suspended Amt NUMBER
Grade VARCHAR
Max Late Charge Number
Limit Expiry Date

Limit Next Renewal Date

2.3.2 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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Auto Contract Ul Enhancement

Overview

In OFSLL to Fund an application in funding stage, user is expected to complete do following
steps

1. Select an Instrument

2. Enter required details like (Contract Date, Amount, term, rate, etc.)
3. Click on Load Instrument
4.

Then need to go to Tools, Initialize, Import Value, Calculate and Copy to Contract.

To improve the Operational efficiency, above steps can be done with a single button click know
as Suggest. This button click will select the first Contract, default all the required details, and fill
all the details required to Fund an Application.

Auto Contract from Ul

1. Anew “Suggest” button is added in Origination >Contract (funding stage) above the Contract
Information table.

n: (MMIO00T011: HAPHADE PAVAN o || Dven | of s
; Bl petact B oo

e

Seasrty Depest Fiovd X verfied It

Contract (3} Suphymant  Namoss

Other Details Tt || e | o agie
vewe Fommt= b §

2. This button is access controlled.

3. Once user clicks on this button, system will do the following actions.

o System will select the first Instrument from Instrument LOV and load the same.

>  System will use the existing procedure to load the instrument and shows error
message if there is an error returned from that procedure call.

e After loading the instrument, System will copy the decision level parameters to Contract.

> Following sheet consists of mapping between decision parameters to contract
parameters for “LOAN, LINE and LEASE”".

Reference: MappingSheet.xlsx

>  After copying the parameters, system will perform “Calculate Payment” [Only for
Loan and Lease Application] “Calculate Tax” [Applicable only for Lease Application
and only if the system parameter SALES TAX INTERFACE is set to INTERNAL and
Sales tax Setup is maintained for INTERNAL Channel].
Note: Only “Calculate Payment” is performed as part of this web service other
options [Calculate Interest Rate, Calculate Term, Calculate Sales Tax (VERTEX)
etc.] are not available as part of this web service.
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e System will use the existing procedure to “Calculate Payment” and shows error message
if there is an error returned from that procedure call.

> “Suggest” Button will be disabled, if the instrument is already loaded in contract.
> If the selected application product is rental, system will not show the “Suggest”

button, as there is no decision details available for Rental application.
2.4.2 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.5 Criteria Based Condition Posting

2.5.1 Overview
In OFSLL, there was no facility to classify account based on some predefined criteria and do
some action on the Accounts. In OFSLL, there was no facility to define the custom conditions and
post the same on the accounts based on configurable parameter setup

New feature provided in OFSLL to add/remove a condition onto an account based on user-
defined selection criteria.

A new tab created in Setup > Queue > Criteria Based Condition to allow user to define criteria to
add/remove Conditions.

Two sub tabs created in this screen namely, Criteria Details and Conditions

A new batch job “CRITERIA BASED CONDITION POSTING” (available in SET-QCS and SET-
QRT) created to execute the setup criteria

Once the criteria matched for an account, system adds/removes conditions defined for the
criteria.

2.5.2 Screen Changes

Screen 1 — Criteria Based Condition > Criteria Details

[ o
don | Customer Service  Call Action Results  Activity Tracking  User Groups
Criteria Definition o add | A Edt | 5 view | & Audit
View v Fomat v [ Freeze 54 Detach Wrap W o checkcriteria
& TEST_D1% [ [E:)
Name Description Start Dt End Dt Seq Enabled
TEST_01 TEST_01 01/01/2016 01/01/2020 onN
Criteria Spadd | A Edit | Bl view || <2 Audit
View v Format~ [ Freeze i Detach wrap (o]
Seq { Parameter Comparison Operator Criteria Value ) ';ﬂf:l‘w Enabled
0 TOTAL DUE AMOUNT GREATER THAN OR EQUAL 100 AND Y
1 DELINQUENCY DAYS GREATER THAN OR EQUAL 300 Y
Inputs and Validation Table
Field Name | Type Default Values | Comments Reference
Name A/N NA Criteria definition code. NA
Should be read-only in edit
mode
Unique
Start Dt Date NA Start Date to consider NA
Criteria for execution
End Dt Date NA End Date of Criteria for NA
execution
Enabled Checkbox N Enabled indicator NA
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e Criteria parameters derived using user defined tables. Following is the default list of
parameters for these values:

Reference: ConditionParameters.xlsx

Screen 3 — Criteria Based Condition > Conditions

Queues x [3€] Close
Origination ~ Criteria Based Condition | Customer Service || Call Action Results || Activity Tracking || User Groups
Criteria Definition P add | g2 Edit || [E] view || < Audit
View v Format v [Ep Fresze i Detach Virap W) | o Check Criteria
& %TEST_CRITERIA £ 2
Name Description Start Dt End Dt Seq Enabled
TEST_CRITERIA TEST_CRITERIA 01/01/2000 01/01/2030 2y
Criteria Defails  Conditions
L Condition b add | A Edit | [ view || o audit
View v Format~ 5P Freeze Hfi Detach Wrap [5F)
Condition Action Enabled
PMT HOLD Open * Close Y
CRITERIA_TEST Open  Close Y
CRITERIA_BASED Open  Close Y
NEW LIEN Open  Close Y

e Anew tab added in Setup - Queue —> Criteria Based Condition - Conditions to
add/remove Conditions.

Note: Please note that the conditions like Delinquency, Scheduled for Charge-Off and TIP are
automatically opened/closed by the system; these will not be allowed to open/close through this
setup

Inputs and Validation Table

Field Name | Type | Default Values | Comments Reference
Condition A/N NA Account Condition Lookup Values from
lookup description ACC_CONDITION_CD
to be opened/closed System posted condition
Unique for each should not be part of this LOV
Criteria definition
code DELINQUENT
SCHEDULE FOR
CHARGEOFF
PAYOFF/TERMINATION IN
PROGRESS
Action Radio | NA Conditions to be NA
Button opened/closed
Enabled Check | N Enabled indicator NA
box
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Servicing Changes

Queues x| Customer Service x E|

Search  Customer Service: 20180100010327  Review Request (Pending: 0)  Queue Assignment

Account(s): 20180100010327: 1 TEST LINEP-00002 E!Eﬂ o nudit
View v Formatv [ Freeze i Detach Wrap W & © curent O show Al O Group Follow-up
Company Branch Sub Unit Account = Master Account #  Master Account Product Billing Cycle Purpose Days Past Due Currency
us01 usHg UNDEFINED 2018010010327  UNDEFINED N LINE HE (VR) MONTHLY VEHICLE LOAN 0. 0 UsD

»

Summary || Collections =~ Customer Service | Account Details | Linked Accounts | Customer Details | Customer Preferences | Transaction History = Pmt Modes | Bankruptcy | RepofForeclosure | Deficiency | Collateral | Bureau | Tim > ~

Call Activities || Maintenance  Comments | Promises | Checklists | Tracking Attributes || Field Investigation || References || Correspondence | Letters | Document Tracking || Access History
»
Comments Hpadd | Zedt || B vew || o audt
view v Format + [0 Freeze i4i Detach Wrap W 3¢ Delete

& %,CONDITION CREDIT% Y
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ‘CONDITION CREDIT INSURANCE AND WARRANTY CANCEL CLOSED BY CRITERIA BASED CONDITION POSTING B... INTERNAL 01/18/2019 04:35:07 AM
N SYSTEM GENERATED SYSTEM GENERATED CONDITION CREDIT INSURANCE AND WARRANTY CANCEL OPENED BY CRITERIA BASED CONDITION POSTING ... [INTERNAL 01/18/2019 04:30:42 AM

On successful posting of Condition, a new comment “CONDITION XXX OPENDED BY
CRITERIA BASED CONDITION POSTING BATCH FOR CRITERIA XXX created on account.

On successful posting of Condition, a new comment “CONDITION XXX CLOSED BY CRITERIA
BASED CONDITION POSTING BATCH FOR CRITERIA XXX” created on account.

Batch Job Changes

e A new batch job “CRITERIA BASED CONDITION POSTING” created to execute these
criteria.

e Once the criteria matched for an account, system adds/removes conditions defined for
that criterion.

o |If the criteria defined to close the condition and the condition is not available (on an
account in Open status), batch job will not pick that Account.

e Similarly, for criteria, which defined to open a condition, if condition is already available
on the Account then Batch job will not pick that Account.

e If batch job picks an account for removal of condition that is not available on the account
then system should not throw error.

e On successful posting of condition, a comment “CONDITION XXX OPENDED BY
CRITERIA BASED CONDITION POSTING BATCH" added on the account.

e On successful posting of condition, a comment “CONDITION XXX CLOSED BY
CRITERIA BASED CONDITION POSTING BATCH" added on the account.

2.5.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.6 Events Framework Enhancements

2.6.1 Overview

Events framework enhanced with below changes:

e Common Events setup for Loan/Line/Lease Product Types.
e Enhanced Event Type’s and Event Actions.

e Added new “Event” indicator in transaction codes to indicate transactions allowed for
Event Types and Event Actions.

e Added support to new Event Action Parameter - Value Type.

e Support custom JSON message, JMS message based on response user defined tables
for an event action. (Note: Too many event actions as JMS configuration might have
performance impact, ensure that due care and properly tested for Application
performance based on Infrastructure configuration).

e Some of the examples that can be configured using events are as follows:

Customer
Customer Address Created Post an automatic comment with Alert
Customer Address Created Send JMS to Customer Hub
Customer Address updated Send JMS to Customer Hub
Customer Telecom Created/Updated Send JMS to Customer Hub
Customer Employment Created/Update | Send JMS to Customer Hub

Account
Account Condition Created/updated | Send JMS
New Transaction Posted Send Letter
New Account Created Send Webhook to the Customer self-service portal
Bankruptcy Created/updated Send Letter
Bankruptcy Created/updated Send JMS
Bankruptcy Created/updated Send Webhook to 3rd Party Attorney
Repossession Created/Updated Send JMS to 3rd Party
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[ ENTITY

H

EVENT

Customer

e

Customer
Created/Updated

Customer Address
Created/Updated

]

Customer
Employment

| Created/Updated

Customer Telecom
Created/Updated

N — Y

]ﬁ[ Criteria

J

Action

~

Selection

Criteria

To filter customer
and trigger Event

l

Post Comment

Send JMS

Webhook

\!
!

K

EVENT

]ﬂ‘ Criteria

H

Action ]

Customer

N ——

Customer
Created/Updated

Customer Address
Created/Updated

Customer
Employment
\ Created/Updated

Customer Telecom
Created/Updated

[

Selection
Criteria

To filter customer
and trigger Event

Post Comment

Send JMS

Webhook

2.6.2 Description

o New Events framework enhanced to support entities (like Customer) that are common

across Loan/Line/Lease Product Types.

e To support these definitions, Event framework definition arranged as a common definition
for Loan/Line/Lease Product Types.
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OLD Events

Events x
Loan | Line | Leasse
Event Types  Event Action Types = Online = Batch | Ewvents
New Events
Events
Loan Line | Lease | Events
Event Types | Event Action Types | Online =~ Batch

Note: Customers using OFSLL 14.6.0.0.0 new event framework will have migration impact and
need to manually revisit /handle the Event definitions post migration.

e For entities (like Account) that has to differentiate between Loan/Line/Lease Product
Types, two new selection criteria parameters are added

>

>

ACCOUNT PRODUCT TYPE CODE
ACCOUNT FUNDING TYPE CODE

SNO PRODUCT TYPE | PRODUCT TYPE CODE FUNDING TYPE CODE
1 LOAN LN CE
2 LINE LN OE
3 LEASE LS CE

e Enhanced support to new Event Types and Actions
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Event Types
> Entity &> Account

-  EVENT TO PROCESS ACTIONS WHEN NEW MONETARY RECORD IS
POSTED

- EVENT TO PROCESS ACTIONS WHEN NEW NON MONETARY RECORD IS
POSTED

- EVENT TO PROCESS ACTIONS WHEN NEW BANKRUPTCY RECORD IS
CREATED

-  EVENT TO PROCESS ACTIONS WHEN NEW BANKRUPTCY RECORD IS
UPDATED
Event Action Types
> Entity > Account
-  POST CALL ACTIVITY
-  SEND CORREPONDANCE
- SEND LETTER
- REQUEST FOR CREDIT BUREAU
- CREATE REVIEW REQUEST
-  POST MONETARY TRANSACTION
-  POST NON MONETARY TRANSACTION
-  POST COMMENT
>  Entity > Customer
-  POST COMMENT

Note:

e Recommended to take acute care while defining the events to avoid any wrong
implementation issues as the impact may be huge in few cases, which may lead to data
corrections or rework etc.

» Avoid Circular dependencies like “Post Call Activity” triggers “Account Comment” and
“Posting Account Comment” triggers same “Call Activity”. Creating such setup
consumes server resources and will have a serious performance impact.

» Customer Based Events co-exists with Non-Monetary transactions and Account
Creation Events co-exists with Monetary Active transaction.

e Anew “SYSTEM DRIVEN" Value Type added to Event Action Parameters. This will
derived the parameter values during the execution of the Event.

SNO | SYSTEM DRIVEN DESCRIPTION
1 $GLDATE GL DATE System Parameter Value
2 $PAYMENTAMOUNT Account Monthly Payment Amount
3 $OUTSTANDINGAMOUNT Account Total Outstanding Amount
4 $RATE Account Rate
5 $TOTALTERM Account Total Term
6 $AVAILABLETERM Account Available Term
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Criteria Details |~ Action

Actions b add | A Edit || [F] view || & Audit
View « Format v E Freeze ﬂ' Detach Wrap Gﬁ
é POST NON MONETARY TRANSACTION CUSTOMER NAME MAINTENANCE
Action Type Action Code Seq Enabled
POST NON MONETARY TRANSACTION CUSTOMER NAME MAINTENAMNCE 8y

Action Parameters

View v Formatv [} Freeze ! Detach Wrap (0]
Description Value Type Value Required
TXN DATE SYSTEM DRIVEN SGLDATE Y
CUSTOMER FIRST NAME [£s] N NEW ACCOUNT Y
CUSTOMER LAST NAME CONSTANT LOAN BATCH Y
CUSTOMER MIDDLE NAME CONSTANT N
RELATION TYPE CODE CONSTANT PRIMARY Y
CUSTOMER GEMERATION CODE CONSTANT IR N

e For Monetary and Non-Monetary transactions, to filter list of transactions applicable for
Event Types and Event Actions can be restricted using “Event” indicator in “Transaction
Codes” setup.

Transaction Codes o
Transaction Super Group
View v Format~ [ Freeze  F4 Detach wirap 5]
Super Group
ACCOUNT MONETARY TXN
ACCOUNT NON MONETARY TXN
AMORTIZATION TXN -
Transaction Codes P add || A Edit | 5] view || < Audit
View + Format~  [i5¢ Freeze it Detach Wrap 50
? Yes
No
Group Action Monetary \Sffsﬁ: pefined  Eoobled Tan/Bal Type Statement Txn Type Batch Manual g::f"‘e”t 6L [Event
ITARY DUTY SERVICEMEN CIVIL RELIEF ACT  POST ¥ Yes ¢ Mo ¥ HONE NONE NoY N Ny
ITARY DU... SERVICEMEN CIVIL RELIEF ACT  POST Y Yes (@ No N NONE NONE K Y N N
RATE CHANGE POST ¥ Yes @ No ¥ NONE RATE CHANGE NN ¥ N
5TE CHANGE RESCHEDULE POST Y Yes @ No ¥ NONE NONE K Y N N
4

Note: ‘Events’ are not supported for transaction groups (STM, POF, YTD, MTD and SEC) in
14.7.0.0.0 and can be scoped in future release based on customer feedback.

e 1In 14.6.0.0.0, system used to send pipe separated message for SEND JMS ACTION.
This message format enhanced to a JSON format as attached below.

Reference: SampleRequest json.txt

SNO | Element Description

1 EventID System Generated Sequence

2 EntityNbr Entity Number (Customer/Account)

3 EventMessage Event Action Message details provided by the user
4 EventType Lookup Code of Event Type Code

5 EventStartDt Event Generation Date and Time

6 EventProcessedDt | Event Process Date and Time

e A new Response Message Details tab added in Dashboard -2 System Monitor 2
Messages to displayed JSON messages. This screen enabled only for “EVENT MDB”
and “WEBHOOK MDB".

2-46 ORACLE

Financial Services


https://docs.oracle.com/cd/F16599_01/pdf/refdocs/ofsll_release_notes_attachments/SampleRequest_json.txt

System Monitor x (]
Batch Jobs  Jobs Services Database Server Log Files  Parked Transactions Users JMS Queues
Status  Messages
View Last ® 1 Day (U 1 Week (0 1 Month () By Date  Start Dt End Dt &
Messages
i Detach Wrap 50}
Service Description Submitted Completed Failed Resubmitted
EVENTS MDB EVENTS MDB s 30 0 0
WEBHOOK MDB WEBHOOK MDB 126 29 59 0
Message Details = view
View = Format = r@ Fresze I Detach Wrap ot}

& 57185291EACH4DE! By
Message ID Request Type Request SubType Message Type Status Message Content Time
87185291EACS4D... OUTEOUND EVENTS EVENT_ACTION COMPLETED REQUEST_TYPE=OUTBOUND|SUB_TYPE=EVENTS|ENTITY_MNBR=0000011001|EVENT_... 04/22/2019 12:58..

Response Message Details

View v Format = Freeze i Detach Wrap @) ViewOption (® Beginning () End # Of Characters 50 Show File Show Al
Text
{"EventDetail”:{"EventID" :158676,"EventType"” :"EMP CREATE","EventMessage" :"PJ - EMPLOYMENT CREATED", "EntityNbr" :"0000011001", "Event
CUOSTOMERS RESPONSE PARAMETER", "StringData": [{"KeyName":"CUSTOMER NUMEBER", "KeyValue":"0000011001"}]}, {"CustomTabName": "EVENT EMPLOYME
3

e “Custom” element message details of this JSON message derived based on User
Defined Table. User can modify these tables to add more fields into JSON response.

Refer Events UDT Mapping.pdf for details.

e Existing “Message Content” is updated with below changes:
> Deprecated “COMMON_NBR” field

> Added new “ENTITY_NBR” field. This field will have Entity Number
(Account/Customer) based on Entity Type

> Renamed “EVE_EVENT_TYPE" identifier name to “EVENT_MESSAGE”

Note: ‘Events’ defined in 14.6.0.0.0 has to be revisited because there are changes in event setup
screen and the references will have impact to existing 14.6.0.0.0 setup.

2.6.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.7 Webhook

2.7.1 Overview

Created new ‘Webhook’ framework to notify third-party applications with OFSLL Events.

e Setup to create Webhook channel to record third-party interfaces
e Register OFSLL Events with Webhook Channel

e View status of transmission of message

e Retrigger failed messages

Example for Webhook:

e If a 3 party application is interested in Account’s moving to Bankruptcy status to inform
Attorney, then a Webhook can be configured to call attorney application whenever
Bankruptcy is posted on the Account.

e When repossession posted on an Account, you can configure third party Auction
endpoint to send details of the Account and Asset for Repossession.

e When Account moves to Charged-off Status then third Party collection agent system can
be informed.

2.7.2 Description

e OFSLL provides Webhook framework to propagate system generated Event notifications
to third-party application. This framework use REST API call to notify.

e Webhook framework has the following:

> Webhook Registry: New WEBHOOK setup screen that records third-party interface
details as a Channel. This screen also allow users to select Events for which
notification are to be sent.

> Webhook Adapter: New WEBHOOK MDB is created to propagate system Events to
third-party as a JSON message using REST API.

OFSLL OFSLL
REST API Third-party
Applications
[CHANNEL 1]
Webhooks
Adapter
[MDB]
™~
Webhook Registry Third-party
[Setup -> Webhook] Applications
OFSLL USER P 2 [CHANNEL N]

e Workflow:

o Created new WEBHOOK setup screen to record third-party interface details that are
interested in OFSLL events.

e On completing WEBHOOK setup, new WEBHOOK action added to Event Framework.
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e Based on activities performed and event definition setup, system will generate Events.

e For all Events with WEBHOOK as the action, an AQ message is placed and is consumed
by WEBHOOK MDB adapter through AQ-JMS Bridge. If there is one Event subscribed to
5 channels then system will place 5 WEBHOOK messages into MDB.

e WEBHOOK MDB will read the channel configuration detail from Database and WebLogic
CSF (Channel Credentials) to propagate JSON message.

e Based on the outcome of call to the external interface system will update the STATUS
and HTTP response code for the message.

e A new Retry batch job picks the failed messages and then resubmits into AQ. The
number of retries is based on a System Parameter. This parameter cannot exceed
more than 5.

P
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Webhook Registry

e Created new WEBHOOK setup screen to register external interface channel details.
Credentials recorded as part of this screen are stored in WebLogic CSF framework.
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QOrganization

s

Channel Setup for Basic

Webhook x (B4
Webhook b add || A Edt | [ view | o sudit
View = Format = ﬁ Freeze &l Detach Wrap @[i {é} Generate {§2=Test
Channel Authentication Mode
EXTERNALINTERFACE-OAUTH20 OAUTH2.0
EXTERNALINTERFACE-HTTP BASIC
Webhook
& save and stay || [ save and Retum || Ga Retum
Channel EXTERMALINTERFACE-HTTP * Authentication mode BASIC v Verified
Client Secret Key ZXIKMGWYQWIPaUpLViFRaUxDS * User Name MANJURED
mhiR2ZNpT2IKS\ XhNalloSLm )
V55npkVOIpTZIKWFIVSKHUMDIMS | 2 *Password eseses
* Service URL | hi 10.184.159.226:950! bhook_¢
Test Service URL +//10.184.159.226:9506/webhook_t
*Enabled [«
Event Details ok add || ZEdit || [S] view | « Audit
View v Format~ [ Fresze i Detach Wrap 5]
Event Event Criteria Service End Point Event Message Enabled
EVENT_ACC_NEW_CREATE_BATCH EVENT_ACC_CREATE_ACCOUNT_BATC... basic EXTERNALINTERFACE-HTTP Y
Webhook x Il
Webhook 9 add | S Edit | [E View | <7 Audit
View v Format = ﬁ Freeze ﬂ' Detach Wrap @fﬂ {§} Generate {§§ Test
_Channe\ Authentication Mode
EXTERNALINTERFACE-QAUTH20 OAUTH2.0
EXTERNALINTERFACE-HTTP BASIC
Webhook
E Save and Stay, E Save and Return @ Return
Channel EXTERMALINTERFACE-OAUTH20 * huthentication mode OAUTHZ.0 ¥ = Identity Domain OF5LL_S50_QA_DOMAIN
Client Secret Key ZXIKMGVYQWIPaUpLViFRaUXDS * Grant Type RESOURCE OWNER PASSWORD ¥ * Token Header Key OFSLL_ACCESS_TOKEN
mhiRZNpT2KSVVEVXhNalUoStm 7
VSSnpkVOIpT2IKWRIVSKUMDIMS 2 * Client Id OFSLL_B2B_TEST_CLIENT *User Name  OLLUSR1
* Service URL  hitps://10.184.159.226:9506/webhook _t = Client Secret . * Password essess
Test Service URL | https://10.184.159.226:9506/webhook_« Verified
* Token URL | http:/fmum00die.in.oracle.com:14100/0:
*Enabled ¥
Event Details Sk add || A Edt || 5 view || < Audit
View v Format~ [ Freeze §d: Detach Wrap (0]
Event Event Criteria Service End Point Event Message Enabled
EVENT_ACC_NEW_CREATE_BATCH EVENT_ACC_CREATE_ACCOUNT_BATC... basic EXTERNALINTERFACE-QAUT Y

Channel

A/N

NA

Third-party Application Name.

Read-only in edit mode

Client Secret
Key

A/N

NA

OFSLL Generated Secret Key.
This is generated on Save and
Return. If already present, use
Generate button to regenerate.

Read-only in Add and Edit

mode

NA
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Field Name

Type

Default Values

Comments

Reference

Authentication
Mode

A/N

NA

Third-party application
authentication mode

A new lookup
WHK_AUTH_M
ODE_CD

Service URL

A/N

NA

Third-party Webhook Service
URL Context.

This URL in conjunction with
Service End Point should only
Accept POST Request.

NA

Test Service
URL

AN

NA

Third-party Webhook Service
URL to check service
availability.

This URL should only accept
GET request and will be
accessed using Test Button.

NA

Grant Type

LOV

NA

OAUTH 2.0 Grant Type

A new lookup
WHK_GRANT_
TYPE_CD

Token URL

A/N

NA

Third-party OAUTH 2.0 token
generation URL

NA

Client ID

A/N

NA

Third-party OAUTH 2.0 client
ID

Will be stored in
“ofsll.int.webhook” CSF map.

NA

Client Secret

AN

NA

Third-party OAUTH 2.0 client
secret

Will be stored in
“ofsll.int.webhook” CSF map.

NA

User Name

AN

NA

Basic Authentication User
Name

Or

Third-party OAUTH 2.0
Resource Owner User Name

Enabled only for Resource
Owner Password Grant Type

Will be stored in
“ofsll.int.webhook” CSF map.

NA

Password

AN

NA

Basic Authentication Password
Or

Third-party OAUTH 2.0
Resource Owner Password

NA
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Field Name

Type

Default Values

Comments

Reference

Enabled only for Resource
Owner Password Grant Type

Will be stored in
“ofsll.int.webhook” CSF map.

Identity
Domain

A/N

NA

Third-party OAUTH 2.0 Domain
Name

Will be stored in
“ofsll.int.webhook” CSF map.

NA

Token Header
Key

AN

NA

Third-party HTTP header key
that OFSLL should use to pass
Access Token Details

Will be stored in
“ofsll.int.webhook” CSF map.

NA

Enabled

Check
box

Enabled indicator

NA

Verified

Check
box

Channel Data Verification

indicator. Will be checked by
system once channel data is
verified using “TEST” button

Read-only in Add and Edit
mode

NA

Note: Refer OFSLL installation document on creation of “ofsll.int.webhook” CSF map.

Event Details:

e Anyrecord added in Webhook = Event Details tab will automatically create WEBHOOK
Event Action to the selected Event Criteria.

e This setup will only display enabled Event and Criteria definitions available. Disabling
Event and Event Criteria will not automatically disable record in Webhook Setup. Ensure
that your system administrator keeps both the setup in sync.

e Webhook Event action will not be editable from Event Setup. Perform all the associated

maintenance from Webhook Setup.

Field Name | Type Default Values | Comments Reference

Event LOV NA Event definition Description. LOV will display
This should will display only enabled Events
enabled records. configured

Event LOV NA Event Criteria definition LOV will display

Criteria Description. This should only enabled Event
display enabled records. Criteria configured

Service A/N NA Endpoint URL. NA

Endpoint
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Field Name | Type Default Values | Comments Reference
Will be propagated to Event
Definition as an Event Action
Parameter
Event A/N NA Event Action Descriptions NA
Message .
9 Will be propagated to Event
Definition as an Event Action
Parameter
Enabled Check | N Enabled indicator. NA
box S .
This indicator will
automatically update
associated WEBHOOK Event
Action mapped.
Events x 3] Close
Loan Line Lease Events
Events HPadd | A Edit || 5] view || o Audit
View v Format = E Freeze i\ Detach Wrap (3]
& EVENT_ACC_NEW_CREATE_BATCH
Event Code Description Entity Type Event Type
ABC EVENT_ACC_NEW_CREATE BATCH  ACCOUNTS EVENT TO PROCESS ACTIONS WHEN NEW ACCOUNT IS CREATED
13
Event Criteria G add | A Edit | B view || o Audit
View v Format = E Freeze i\ Detach Wrap ) o Check Criteria
4 EVENT_ACC_CREATE_ACCOUNT_BATCH_LEASE
Query Mame Description Enabled
ABC EVENT_ACC_CREATE_ACCOUNT_BATCH_LEASE ¥
Criteria Details =~ Action
I’T!ud:ions H add || A Edit || [E] view || o sudit N
View ~ Format = % Freeze i Detach Wrap 0]
& WEBHOOK
Action Type Action Code Seq Enabled
WEBHOOK NONE 1Y
WEBHOOK NONE 1y
Action Parameters
View w Format « % Freeze ﬁj' Detach Wrap @ﬂ
Description Value Type Value Required
CHANNEL CONSTANT EXTERMALINTERFACE-HTTP
EVENT MESSAGE CONSTANT EXTERNALINTERFACE-HTTP
URL PARAMETER CONSTANT BASIC
. A

e “Generate” button is used to generate OFSLL specific Client Secret Key.

>  System will generate “X-Hmac” header using “HMAC SHA 256" and will propagate
this header during the call of Webhook service for the configured channel.

> Use this header to validate the integrity of the source.
> This generation algorithm uses below logic

Format:

“OFSLL": Base64 Encoded [HMAC SHA 256 of [“Http Method Types”:"Base64 Encoded
Payload”:” Http Content Types”: “Service URL"] with Client Secret Key]

Example:

Client Secret Key

ORACLE
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TOZTTEXfQjICX1RFU1IRfQOXJRU5UONdIbGNvbWUX

Cipher Text for HMAC SHA 256

POST:ewoglICAgIlJlcXVIc3RUeXBlljoglk9VVEJPVUSEIgp9:application/json:http://10.184.
159.226:9006/webhook/service/api/resources/webhook/basic

Generated Sample “X-Hmac” header
OFSLL:g6xCpZrnudfB8owvYEi2+Aac4clM3b/XFVTVrChdQKA=

e Click ‘Test’ button to verify configuration details of the external channel.

> External system should generate “X-Hmac” header using “HMAC SHA 256" and
propagate this as part of response header to OFSLL.

» Channel name is used in HMAC digest as given below. This is passed to the external
interface using HTTP Header Key “ChannelName”. This value will be in base 64
encoded format.

>  System will validate this response and update the Verified indicator. Only HTTP
status code 200 is considered as success to validate response.

> The generation algorithm uses below logic.

Format:

“OFSLL": Base64 Encoded [HMAC SHA 256 of [“Http Method Types”:"Base64 Encoded Channel
Name”™:” Http Content Types”: “Service URL"] with Client Secret Key]

Example:

Client Secret Key

ZXIKMGVYQWIPaUpLVjFRaUxDSmMhiR2NpT2IKSVV6VXhNaUo5LmV5SnpkVOIpT2IKW

FIVSKIUMDIMSWI3aVEwaEJUazVGVENJINKI'VIWRVZTVGtGTVNVNVVSVkpHUVVOR
kxVOUJIWVIIITWpBaUxDSNBjMO1pT2IKUFISTKk1URjIYUIVKSVQwOUxJaXdpWIhodOlg

b3hOVFUXTmpnMU1gSXpMQOpwWVhRaU9qRTFOVFUYTORRNU1qTjkuemxMbOlzdw

duek1FRnhyblcxYXJIeXNMSFIiISmVQdOR5SUxvdDdUaXZDMEFVUKtEbm5WeDJIpWmR
iT1pJald5aHNfSWxNaG1IV1dWZUFOYmZRUNI1X2c=

Cipher Text for HMAC SHA 256
GET:RVhURVJOQUxJTIRFUkZBQOUtTOFVVEgyMA==:application/json:https://10.184.15
9.226:9506/webhook_oauthga/service/apilresources/webhook/test

Generated Sample “X-Hmac” header
OFSLL:F/jjo7ghgM3g5z91EHU/rdxYbaJ266SRnXsBRoUxgUc=

Webhook Adapter

e Event framework triggers Webhook Action. As soon as an Event is triggered in OFSLL,
system will check if there are any Webhook Actions defined for different channels. If there
are multiple channel registries available for a single Event, OFSLL will create multiple
WEBHOOK DB AQ messages to propagate the event details to external channels.

e A new WEBHOOK MDB processes these messages. It will read these messages and
process WEBHOOK request based on JSON request created from User Defined Table
available for individual Events. The JSON message generation process is similar to
EVENT JSON message generation.

e  When WEBHOOK MDB POST JSON request to external channel, system expects to
return only below HTTP status codes.
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HTTP Status Code | MDB Dashboard Status | Description

2XX, 3XX COMPLETED

AXX FAILED Need to resubmit manually.
MDB will update retry count to 5

5XX FAILED Will be resubmitted by batch job

e Anew System Parameter “EVI_MAX_RETRY_COUNT” records max attempts to
retrigger FAILED status messages. This parameter cannot exceed more than 5. If user
wanted to manage max retrigger less than 5 times use this system parameter.

e Anew batch job SET-EVE - EVEPRC_BJ_100_02 picks FAILED status messages.
This functionality is similar to MDB Dashboard “Resubmit” button. This batch job will
consider system parameter “EVI_ MAX_RETRY_COUNT" to determine max retrigger.

e System Parameter “CMN_HTTP_CONNECTION_TIMEOUT” determines max time
(seconds) external channel should take to respond to OFSLL. If response time exceeds
the system parameter then system will mark the request as FAILED with 500 HTTP
Status Code.

e |If the system is running behind a firewall/proxy network, OFSLL provides below system
parameters to configure proxy details.

SNO | System Parameter Description

1 CMN_HTTP_PROXY_ENABLED_IND PROXY INDICATOR FOR ALL
OUTSIDE HTTP/HTTPS
CONNECTION

2 CMN_HTTP_PROXY_PORT HTTP PROXY SERVER PORT

FOR OUTGOING HTTP
CONNECTIONS

3 CMN_HTTP_PROXY_SERVER HTTP PROXY SERVER FOR
OUTGOING HTTP
CONNECTIONS

e Added new field “Response” to existing MDB Dashboard for Webhook MDB. This field is
only displayed for WEBHOOK MDB. It records HTTP Status Code received as response
during invocation.
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System Monitor x [®d
Batch Jobs  Jobs  Services | Database Server Log Files  Parked Transactions = Users = JMS Queues
Status ~ Messages
View Last @® 1 Day () 1 Week (J 1 Month () By Date  start ot End Dt -]
Messages
& Detach Wrap 5]
Service Description Submitted Completed Failed Resubmitted
EVENTS MDB EVENTS MDB 44 30 0 0
WEBHOOK MDB WEBHOOK MDB 126 29 59 0
Message Details E] view
View + Format ~ | [ Freeze ! Detach wap @

& 8718CD31E1A45961 B
Message 1D Request Type Request SubType  Message Type Status Response Message Content Time
871BCD31E1A459.. QUTBOUND WEBHOOK WEBHOOK COMPLETED 201 REQUEST_TYPE=OUTBOUND|SUB_TYPE=WEBHOOK|ENTITY_NB... 04/22/2019 01:33

Response Message Details

View v Format = Freeze g Detach Wrap ) ViewOption (® Beginning () End £ of Characters | 50 Show File Show Al
ntID"

Field Name | Type | Default Values | Comments Reference

Response A/N NA Used to record HTTP Status | NA
Header response received
during invocation.

In case of timeout, 500 HTTP
Status will be stored

2.7.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.8 Ul Extensibility / Configurability

2.8.1 Overview

Field Configuration and Label Changes (Producer screen only)

OFSLL supports the following configuration:
e Ability to configure to hide / unhide user defined fields in a screen.
e Ability to Change the Label based on language and Division.
e Ability to change the tool tip.
e Ability to control access of non-mandatory fields based on responsibility.

2.8.2 Description

Ability to add new fields to screen or add new Tab to Existing Screen
e Provided User Defined Extensible fields at each Entity in all layers Ul, backend.
e Supports Entity level UDF fields showing up in Producer and related screens as follows:
e 20 Fields, which includes 10 Text, 5 Number and 5 Date fields.

Ability to change label & Provide Access to fields:
e Entity level UDF fields showing created above shows up in the producer screen.
e Allows facility for Run-time label change of Ul and these Labels to be customizable by
Division.
e Run-time column view/hide on form layout.

System Parameter to enable configuration
New system parameter ‘cmn_label_custom_enable_ind’ introduced to indicate whether
configurability is enabled or not.

e If the parameter value = Y, system refers the data from database (new behaviour)

e If the parameter value = N, system retains the existing behaviour i.e., reference of
details are from XLIB file.

To support the above mentioned configurability points, existing ‘Access’ screen has enhanced as
indicated below.

atn | Screen  feperts  Comemondence | Trarsaction | Webservie

Security Super Group S e | o mt
View = Foma - B e [ Detach o "]

S Fackd Access Defistion

Security Access Definition e add | M Ed L) e o Ayt
viaw v Format = 28 [ Desach i

0 o

AecmmCode [seowson 3 Tyom SyttemDefred B satriomt

PRODUCE. COMMENTS VIEW DBIECT || 510 PRODUCER. Te o v ~

USER DEFINED FIELD:
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Add Screen:

Security Access Definition

[Hsaveandadd | [ SaveandStay || [ Save and Return | {5 Retun
* Language v * Field Name - *Enabled
S 3 ot Ora®te )
Details:
Field Name Data Type/ Tool | Mandatory | Default Value Comment
Language LOV Y English Select Language from LOV
Division LOV Y NULL
Object Name | LOV Y NULL Choose the object name for
required tab using search
option within LOV
Field Name LOV Y NA LOV shows only list of fields
corresponding to selected
object, where user can
select.
Access Type | LOV Y NULL Read Only — Makes field
visible to user, but read only.
Editable — Retains the field
editable (if base field is
editable)
System Radio Button Y Yes for base
Defined fields and No
for UDF fields
Enabled Check Box Y Y Check this box to apply

changes for row.

Security User Access Definition Details

Access Type

LOV

Y

Responsibility

Refer lookup
ACCESS_GRID_TYPE_CD
and show only
‘Responsibility’.

Access Value

LOV

ALL

List of responsibilities
including ALL.

Allowed

Radio Button

By default, provided access
to field to ALL user
responsibilities. If user want
to restrict, choose the
responsibility and set the
allowed value to N.

Enabled

Checkbox

Indicates the record is
enabled or not.
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Validations & Logic:

As part of release, provided the seed data to show the list of Objects and field list ALL Company.

EDIT Screen:

Field Access Definition

] saveand Stay || [ Save and Return

(;) Return

* System Defined O Yes@®) No
* Enabled

Access Code ENG.OD-
002.UPRPROCPPVO.PROLOSSRESERVEAMT.VIEW.FIELD

Description
* Type ~
Field Name Data Type/ Tool | Mandatory | Default Value | Comment
Access Code | View Only Y Shows the Access code
selected
Description Text Field Y Defaults the User can change the
access description
description
Type LOV Y Select the type
to regroup the
field
System Radio Button Y
Defined
Enabled Checkbox Y
Access Responsibil | Access Responsibil
KEY Type 1 ity Type 2 ity Result
GRAD Show the field, But
E VIEW Allowed =Y | LOCK Allowed =N | not editable
GRAD Show the field with
E VIEW Allowed =Y | NO LOCK NA editable
GRAD Show the field with
E VIEW Allowed =Y | LOCK Allowed =Y | editable
GRAD Doesn't show the field
E VIEW Allowed =N | LOCK Allowed =Y | on screen
GRAD Doesn't show the field
E VIEW Allowed =N | NO LOCK NA on screen
GRAD Show the field with
E NO VIEW NA LOCK Allowed =Y | editable
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KEY

Access
Type 1l

ity

Responsibil

Access
Type 2

ity

Responsibil

Result

GRAD
E VIEW

Allowed = N

LOCK

Allowed = N

Doesn't show the field
on screen

To support the label change related changes, new tab ‘Label Configuration’ screen has
introduced (which looks like in print screen below).

Tool

Label Configuration x (3] Close
Label Configuration A Edt || 5 view || 2 Audit
view v Format> [EJ] | Freezz [fivetach wap @ Language ] Division O] $load {83 Update
¢
Language Division Type Object Name Field Name Data Type User Defined Label Todltip Required |
ENGLISH 0D-001 HEADER UNDEFINED UNDEFINED UNDEFINED Summary UNDEFINED N "~
ENGLISH 0OD-001 TAB UNDEFINED UNDEFINED UNDEFINED Summary UNDEFINED N
ENGLISH 0OD-001 HEADER UNDEFINED UNDEFINED UNDEFINED Title Status Summary UNDEFINED N
ENGLISH 0OD-001 TAB UNDEFINED UNDEFINED UNDEFINED Title s Summary UNDEFINED N
ENGLISH 0OD-001 TAB UNDEFINED UNDEFINED UNDEFINED Tracking Attributes UNDEFINED N
ENGLISH 0OD-001 HEADER UNDEFINED UNDEFINED UNDEFINED Transactions UNDEFINED N
» ENGLISH 0OD-001 TAB UNDEFINED UNDEFINED UNDEFINED Transactions UNDEFINED N
ENGLISH 0OD-001 HEADER UNDEFINED UNDEFINED UNDEFINED ACH STATUS = UNDEFINED N
ENGLISH 0OD-001 HEADER UNDEFINED UNDEFINED UNDEFINED STATUS : UNDEFINED N
ENGLISH 0oD-001 FIELD UprAccHbkVO AccProducerHoldbackAmt NUMBER Holdback Amt Test Displays proceed holdback amount N
ENGLISH 0OD-001 FIELD UpraccHbkVO DspAccApphbrTite VARCHAR Account UNDEFINED N
ENGLISH 0D-001 FIELD UprAccVo AccAppChbkamt NUMBER Chargeback Amount Displays chargeback amount N
ENGLISH 0OD-001 FIELD UprAccVO AccAppChbkChgoffDays NUMBER Charge Off Days Displays Chargeback days in case of chargeoff N
ENGLISH 0D-001 FIELD UprAccVO AccappChbkChgoffPer NUMEER Charge off Percent Displays Chargeback compensation percentage in case of char.. N
ENGLISH oD-001 FIELD UprAccVO AcchppChbkChgoffTerm NUMBER Charge Off Term Displays Chargeback term in case of chargeoff N v
< >
Details:
Field Name Data Type/ Mandatory | Default Value | Comment

Search Criteria

Language

LOV

English

Division

LOV

ALL

Type

Display

Indicates whether the object
is Tab / Field / Button /
Header / Sub header

Object Name

Text Field
(Read Only)

NA

Shows list of objects

Field Name

Text Field
(Read Only)

NA

Shows only list of fields
corresponding to selected
object.

Data Type

Indicates field data type (Not
applicable for headers tab
and shows blank)

User Defined
Label

Text Field
(Editable)

Same as
Actual Label

Labels can be change for all
fields (including base fields).

Tool Tip

Text Field
(Editable)

NA

Shows tool tip of
corresponding field.
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For UDF, this seed data to be
provided and allow user to
edit.

Default Value

Text Field Y
(Editable)

UNDEFINED
for varchar

0 for Number

Sys Date for
Date

User can input default value
for any field, which shows in
corresponding screen.

Required

Check Box Y
(Editable for
UDF)

NA

Indicates whether the field is
required or not and allowed to
modify the value of UDF.

Display
(Yes/No)

Check Box Y

For Custom
fields show as
‘N’ and for
base fields
show as 'Y’

Indicates whether the field is
to be displayed on screen.

This field is editable, if
required value ="'N’.

Only optional fields can be
hidden

System
Required

Ready Only Y

Indicates whether the field is
system required. If Yes,
system does not allow user to
modify fields — Required,
Display, Enabled.

Enabled

Check Box Y

Check this box to apply
changes for row, where any
label or render condition
change are done and ‘Apply
Changes’ button is clicked.

Matrix

Base Field

User Defined Field

Comment

Label Change

User can make changes

User can make changes

Data Type

Displayed

Displayed

Identify the data
type by field

Default Value

User can make changes

User can make changes

Cannot show the
default Value

Required Not allowed to modify this | Allowed to set the
parameter parameter for UDF
Display (Yes/ Allowed to make the Allowed to make the Cannot change
No) Display as NO for Non- Display as NO for Non- property of
mandatory fields mandatory fields mandatory base
field
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Validations & Logic

e As part of release, provided the seed data to show the list of Screen, Tab List and Field
list for ALL Division and Load button loads the data.

e Label Configuration screen is applicable for both table and form layout i.e. if a field has
been marked to hide, the same is hidden from both table as well as form.

Update Button

Update button provided in above screen to refresh cache automatically, to avoid the app server
restart. ‘Update Button’ refreshes data from database server to app server.

2.8.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.9

29.1

Add Existing Customer - Non-Monetary Transaction

Overview

OFSLL currently supports only to add new customer to account during servicing.

In current release, new transaction created to add existing customer to account in servicing

stage.

2.9.2 Description

Non- Monetary Transaction — Add Existing Customer

Following new non-monetary transaction introduced with parameters

Financial Services

Txn Descri | Group | Acti | Mon | Syst | Ena | Txn | St Bat [ Man | St | G
Code | ption on etary | em ble |/ mt | ch ual mt | L
Defi Bal | Txn Pri
ned Typ | Typ nt
e e
CUS_ | ADD CUST | POS | N Y Y NO | NO | N Y N N
EXIS | EXISTI | OMER | T NE | NE
T _AD | NG NON
D_MA | CUSTO | MONE
INT MER TARY
Transaction Parameters:
Paramete | Descriptio | Mandator | Data Field Defaul | Comments
r Code n y Y/N Type/ | Validation |t
Size Value
S
Txn Date | Transactio |Y Date Doesn’t Syste
n Date Field allowany |m
back Date
dated or
future
dated
transactio
n.
Existing Input field Y Text NONE
Customer Field -
# Numbe
r
Relation Select Y LOV Refer
Type relationship RELATION_TYPE_C
Code of newly D
added
customer
to account.
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Comment | Input N Char Null
Comment

Validations

On Save, system does the following validations and throw error messages:

Field Name Validation Error Message
Txn Date Accepts current System Date Standard Error message for date
validation.
Existing Checks if the customer is not Customer selected is deceased.
Customer # deceased. If ‘Deceased’ shows error Please select the active customer.
message.
Existing Checks if the customer is marked as Customer selected filed
Customer # ‘Bankrupt’. If marked as bankrupt Bankruptcy. Please select the
shows error message. active customer.
Existing Checks if the customer number Show Error message as ‘Customer
Customer # provided already attached to account. | Number’ provided belongs
If Yes, shows error message and do customer, already attached to
not allow to post transaction. account.
Example:

For SSN / National ID:123456789

Customer # attached to SSN are
1234, 5678

If the account is already having
customer with Customer # 1234
and user is trying to add existing
customer with customer # 5678;
system has to identify that same
customer is2 already attached,
which is having either same SSN
Number or National ID.

Relation Type | On save, if the relation selected for If selected Relation Type already
Code customer is already attached to exists, please select the different
account, shows error message and relation.

doesn’t post the transaction Example: If Primary and Spouse

relation types are already attached
members of account, show error
message, if user trying to attach
customer with same relation.

On successful posting of transaction, following actions performed on account:

System attaches customer to account and update the flag to ‘Joint’ = Yes, if the flag is ‘N’ (in case
of single customer account).

Impact Handling

GRI - Customer Addition would trigger details update to GRI.
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2.9.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.10 Securitization Pool Upload

2.10.1 Overview

Enhanced Securitization functionality with below capability:
1. Introduced new field to indicate account as ‘securitization Eligible’ in servicing and conversion
2. Enabled securitization file upload to do following actions:

e Add Accounts to pool

e Remove Accounts from the pool
e Transfer account from Pool A to Pool B (for configurable statuses).

2.10.2 Description

Securitization Eligible

Introduced new field ‘Securitization Eligible’ under Servicing = Account Details = Account
Information > Others.

Field Field Description Data Type Default Value | Comment

Securitization | Indicates Account Varchar2 — N Related functionality

Eligible eligible for Text box handled in next release.
securitization

File upload facility to handle pool Account
Addressed the following cases:

The purpose of this file definition is to allow the following actions:

e Add Accounts to pool

Remove Accounts from the pool
Transfer account from Pool A to Pool B (for configurable statuses).

New Batch Job:

New batch job (ISCPRC_BJ 100 _01) created under the SET-IFP, Input file processing.
This batch job reads the file from ISC folder (<OFSLL>/input/isc) and uploads the
accounts on to the Pool.

Action on running of batch job:

Sl.no. | Pool Id in File Pool Id on Current | Action Action Details
Account
1 I= UNDEFINED UNDEFINED Add to new Pool Post ‘Add Account’
(ABCD) transaction on Pool
ABCD
2 UNDEFINED I= UNDEFINED Remove Account Post ‘Remove
(ABCD) from existing Pool Account’ transaction
on Pool ABCD
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Sl.no. | Pool Id in File Pool Id on Current | Action Action Details
Account
3 I= UNDEFINED 1= UNDEFINED Remove Account Post ‘Remove
(ABCD) (EFGH) from existing Pool Account’ transaction
and Add to New on Pool EFGH
pool Post ‘Add Account’
transaction on Pool
ABCD
4 SAME as Pool Id SAME as Pool Id Do Nothing and Show Error —
on Account in file (ABCD) Report error Account already
(ABCD) mapped to Pool.
Field Details and Validations:
Field Description Data Type Manda | Validation
tory
Pool Id This field should Varchar2(30) | No Valid Pool Id required and
consists of valid pool Id additional validations -
documented below.
Account This field should Varchar2(30) | Yes Account number should be
Number consists of valid valid and additional
account numbers validations - documented
below.

System checks the validations related to accounts and ignores query qualification criteria
(if any) to upload accounts to pool.

File definition is comma separated file.
On transferring an account from Pool A to B, system posts transactions on each pool.
‘Remove Account’ transaction on pool A and ‘Add Account’ transaction on Pool B.

Txn: ‘Remove Account’ on From Pool Transaction posted on pool A with following
information

Reason: Pool Account Transfer

Date: System date of file upload.

Txn: ‘Add Account’ on To Pool transaction posted on pool B with following information
Reason: Pool Account Transfer

Date: System date of file upload.

Note: This txn is posted, only after validating ‘From & To Pool Id’ details.

Transferring account from Pool A to UNDEFINED, system posts transaction on pool A.
> ‘Remove Account’ transaction on pool A posted.

Validation Field Validation Error Action /
Applicable to Action Message | Comment
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134 Pool Id If the pool Id provided in file is | Pool ID Processes
not existing or NULL doesn’t valid rows and
exist rejects the
corresponding
record and
show reason
in error log.
12,34 Pool Id If the pool status is not in the | Invalid Processes
configured list of statues Action valid rows,
(From and To) Code. rejects
corresponding
record and
shows reason
in error log.
12,34 Account If the account number is not List of Processes
No. found, batch job rejects the rejected valid rows and
corresponding record to records — | rejects the
upload / transfer Reject corresponding
Reason record and
show reason
in error log.
1,3 Account | If the system parameter List of Processes
No. POOL_ACTIVE_ACCOUNTS | rejected valid rows,
_ONLY is Y and file contain records — | rejects the
accounts other than ‘Active’ Reject corresponding
Reason record and
shows reason
in error log.
1,3 Company | If the pool = Account List of Processes
Company is different from rejected valid rows,
Pool Company records — | rejects the
or Reject corresponding
Reason records and
Account Company of From (Cannot shows reason
and To Pools are different, process in error log.
system rejects record. record,
Company
Mismatch)
1,3 Product If the pool - Product Type List of Processes
Type belongs to ‘Loan’ and file rejected valid rows,
contains ‘Lease’ accounts or records — | rejects the
vice-versa Reject corresponding
Reason records and
e e o oo | (Canot | shows reason
process in error log.
Or record,
Account Product Type of _I;;c;(iuct
From and To Pools are Mismatch)
different, system rejects
record.
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Setting up the configuration:
e System allows to Add / Remove accounts from pool only for the configured pool statuses.
e To enable this, created new lookups as follows:

POOL_ADD_ACC_CRITERIA (CRITERIA TO ADD REMOVE ACCOUNT FROM POOL)
POOL_REMOVE_ACC_CRITERIA (POOL CRITERIA FOR REMOVING ACCOUNT)

Following seed data maintained in base:
POOL_ADD_ACC_CRITERIA|CRITERIA TO ADD REMOVE ACCOUNT FROM
POOL|NJY
POOL_REMOVE_ACC_CRITERIA|POOL CRITERIA FOR REMOVING ACCOUNT]INJY
POOL_ADD_ACC_CRITERIA|H|[2|HELDI|N|Y
POOL_ADD_ACC_CRITERIA|O||1|OPENIN]Y
POOL_REMOVE_ACC_CRITERIA|N||2INEW|N]Y
POOL_REMOVE_ACC_CRITERIA|O||1|OPEN|N|Y

Assumption:

e User creates the pool from screen and mentions the exiting pool ID in file to upload
accounts to existing pool. (File does not create any new pool).

e System transfers Account between two pools ignoring the pool class / type.

Sample File: SecuritizationFileSample.txt

2.10.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.11 Correspondence Change

2.11.1 Overview

Multiple Template Support

OFSLL refers the document definition and currently only one template can be mapped to each
event.

After change, user can define the multiple templates for each event and BIP template is picked
based on criteria — Product and Producer / Account / Customer State.

[ Before 14.7.0.0.0 release ] [ Post 14.7.0.0.0 release ]

Document
Definition

Document
Definition

1. User can define any number of

templates
2. BIP template reference is taken

from “Document Template” (File
Document name in Document Template)
Elements

Document
Elements
Note: Template is picked based on
following Criteria

-Product, Producer, Account,

Reference taken
from Document

Definition Customer State
Document Document
Template Template
BIP - BIP
Template Template
N— N—
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2.12 Reason code for All Non-monetary Transactions

2.12.1 Overview

Reason Code configuration in hon-monetary transactions

Provided seed data for reason code in ‘Flex Table attributes’ and corresponding lookup codes
and values.

User has to enable the ‘Reason Code’ for corresponding non-monetary transaction to input while
posting transaction.

Attribut | Desc |Data |Le |S |Ope |Sy |En | Sub |LO | LOV | Lookup | De
e riptio | Type | ng | o |rato | ste | abl | Attr | V Vali | Type fau
n th |rt |r m ed ibut | Ty | dati It
Def e pe | on Val
ine Ind ue
d
(Y/
N)
TNM_RE | Reas | CHA | 30 LIK |Y Y Lo |Y TNM_RE
ASON_C | on RCT E ok ASON_C
D Type | ER up D
Reference Lookup Details
Lookup Type Description System Defined (Yes / No) | Enabled
TNM_REASON_CD | Reason Type | Y Y

Lookup Code | Description | Sort | Sub code | System Defined (Yes / No) | Enabled

TRADE Trade 0 ACC Y Y

GRADE Grade 1 ACC Y Y

2.12.2 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.13 Conversion Enhancements

2.13.1 Overview

Updated the existing SET-API process with below changes.

e Added unique constraint for Asset # in Customer Servicing and Collection. This might
have migration impact if existing customer is using duplicate asset numbers. In such a
case, you need to update existing asset number to unique values.

Loading Account Conditions

e Conversion process enhanced to consume account conditions dat file. However, system
generated account conditions should not be included in dat file and process validates to
stop loading system generated conditions.

e System supports loading enabled Account Conditions using API process. This process
does not allow loading below conditions and on successful conversion of account certain
conditions like DELINQUENT would be posted on account by API process.

> DELINQUENT

> SCHEDULE FOR CHARGEOFF

> PAYOFF/TERMINATION IN PROGRESS
> NON ACCRUAL

> BANKRUPTCY

> DEFICIENCY

> REPOSSESSION

> FORECLOSURE

Loading Bankruptcy Information
e Enhanced conversion process to consume bankruptcy information dat file.
o Earlier bankruptcy details are conversion process driven by defaulting few values.
e After enhancement user can supply bankruptcy details, which would be loaded to OFSLL.

Account Conversion Line

Enhanced following screens in ‘Line Conversion Accounts’ with new/update fields.
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Contract Main Table:

Applicant | Business | Request | Decision . Contract | Collateral | Account Detalls | Comments | Verification

Contract Information
Views Format~ B 1] Frecse [ Detach ol
Contract Dt Term 1st Pt Dt Drawe Term|  Réspert TermMaturity Dt Indix Margin Rate Due Dary
07/29/2018 a2 7] o azfagaarzone FLAT RATE | 4.9000 _
‘ : v
Revd Dt Verified Dt PDC Ind  Promotion  Maturity Endex § Stmit Preference Mode:
Contract Edit Section:
CONTVEnsion ACCounts s () o
Contract Information - -
| B o s st ||| o o ot || ot |
Start Days Advanee
Contract Detalls
FDC Security Ind. Tritinl Advarce Min 10000
* Confract Dt 07/29/2016 B ACH Fee Ind Inifial Advance M LOKCO

Instrumant LINE OF CREDIT HOME EQUITY Advance Hin 10000

. Promation Details - 100,
Credit Uit | 50,000,00 il cirtiat
* Promotion UNDEFINED v Billing
* Reot Term |12 Type NONE
Tom 6 Draw Period Biling Method  INTEREST OMLY
* Term |13 T 3
Draw Pericd Payment % 0.0000
m— Iidex FLAT RATE
| maturity o 13/20/3019 | : Reprnt Period Billng Method  PERCENTAGE OF PRINCIPAL PLUS
Indesc Reter  0.0000 INTEREST
» * Index | FLAT RATE v Margin Rete £.0000
oignra Report Pericd Payment % 2.0000
Index Rate 0.0000 Rate 0.0000 Min Paymert Amt. 50,00
* Margin Hate |4.9900 Hin Finance Charge 100
fate 49000 Rats Caps. and Adjustments Acvance Tolerance 10,00
* 1P DU 1329018 Y Adirrce Toksance 8 0.0000
TR
B — “Accriol Pest MatLry
* Matwity Index | FLAT RATE »
* ol Dt 07/20/2018 B
* Matirity Rate 4.9300
verified DU 0772972018 %
Verfied By Others
* POC Ind & ol Adps [ Yeor 99,0000
#of Acks  Life 9990000 | strot prefesemce Mode + |

Instrument Details
Sttt Bass EFFECTIVE [ATE

Accrual Method  AVERAGE DWILY BALANCE

‘Fovas WUSTW A TVIAT (A0 T1 U]

Account Details > ‘Details’ Main Table:

Conditions ~ Balances  Transactions | ACH | Bankruptcy Chargeoff  Detalls  Tracking Attributes

Additional Information L Edt || ] wew
View = Format « ? Freeze || Detach ¢ Wrap ]
l Stop Accrual Accrued Interest[index Type Index Rate Margin Ratd Rate Last Rate Change Dt Accrual Start Dt Last Accrual Dt Rate S of the
N FLAT RATE 0.00 4.99 499 07/79/2018 03/08/2019
o - -
s = o
0 [ 0 0

Suspended (-] Available Credit (=) Owver Limit Year Over Limit Life Advance Dt Last Advance Amij Time Zone
0.00 50,000.00 o 0.

Credit Li
50,

Account Details > ‘Details’ Edit Section:

Mdditional Information

| B save and stay || B sove and Retum || GaRetum |

Interest and Accruals Extn and Due Dates Heold (-} 0.00

Stop Accrual — Consumed (-) 0.00

Accrued Tnkerest # of Extenssions (Year) 0 Suspended () 0.00
Inche: Typee  FLAT RATE = of Extensions (Life) 0 Awailable Credit (=) 50,000.00

Index Rate 0,00 # of Extension Term (Year) 0 Cwer Limit Year 0.00

Margin Rate 4.99 # of Extension Term (Life) 0 Over Limit Life 0,00

Rate 4.99 # of Due Dt Changes (Year) Last Advance Dt
Laxst Rate Change Dt # of Due Dt Changes (Life) Last Advance Amt 0.00
Accrual Start Dt 07/29/2018 Lasst Extny Dt
Last Accrugd Dt 03/08/2019 Due Day Chy Dt b
Rate Start of the Year Dthers

# of Rate changes (Year)

# of Rate changes (Life) Credit Details Tirme Zone

Credit Limit  50,000.00
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2.14 Customer Score Refresh

2.14.1 Overview

Provided facility to maintain record of scores for Customers and Business.

During the service and lifecycle of the credit/ loan, it is required that updated Customers scores
are maintained in OFSLL that could give a snapshot of credit score movements in recent history
and not just stick to one particular score obtained during funding.

Customer Score

Created an account level new non-monetary transaction as “Customer Score Update”.

On posting this transaction a record will be captured under ‘Customer Service >

Customer Details > Customer > Customer Score [New Tab]'.

Below are the Transaction Code details:

T>n Acti | Mon System Enab | Txn/Bal | Statement
Description | Group Defined led Type Txn Type
Code on etary
(Yes/No)
CUS_ | CUSTOME | CUSTOMER PO
SCOR | R SCORE NON ST N NO Y NONE NONE
E UPDATE MONETARY
Batch | Manual Stgtement GL
Print
N Y N N
e Following are the transaction parameters and field details.
S No Field Name Field Format Mandatory | Default Value
1 TXN DATE Text Box with Calendar Y NA
2 SCORE RECEIVED DATE | Text Box with Calendar Y NA
3 RELATION TYPE LOV [ RELATION_TYPE_CD] |Y Primary
4 SOURCE [EXP/EFX/TUX] | LOV [CRB_SOURCE_CD] Y NA
5 SCORE Text Box Y 0
6 REFERENCE NUMBER Text Box N
7 REASON CODE LOV [New LOV development N
WIP for Non-Monetary
Transactions]
8 COMMENTS Text Box N

Note: If in one account “Customer Score Update” transaction is posted, then system posts this
transaction to all the accounts linked to that customer.
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e Provided new “Customer Score” tab, under ‘Customer Service > Customer Details >
Customer’ to maintain the record of customer score data.

Summary | Collections

Customer

Customer Service | Account Details | Linked Accounts | Cu

Customer Information

View ~ Format ~

Customer #

0000002004
0000014003
0000020051

Addresses | Telecoms

B Fresze

@ show Al

Relation Name

PRIMARY
SPOUSE
SECONDARY

INDIVIDUAL TEST LOAN-EBR-5
LOAN TEST 4

ABC DEF

Employments  Tracking Attributes  Customer Score

stomer Details ~ Customer Preferenc

es | Transaction History =~ Pmt Modes

Customer Decease

=L Date

Birth Dt

05/09/1530
01/01/1998
02/13/2000

000123
0000000
0-3006-0000

Bankruptcy | RepofForedlosure

Marital Status
UNDEFINED

Deficiency  Collateral | Bureau  Tim > T

A Edt || [5] view || < audit %

Enabled Language Education

Y ENGLISH
¥ ENGLISH

UNDEFINED

>
El

View ~ Format «

Customer Score Information

rence Number  Reason Code

Comments

TRADE TEST

View || <@ Audit

Business Score

e Created an account level new non-monetary transaction as “Business Score Update”.

e On posting this transaction a record will be captured under ‘Customer Service >
Customer Details > Business > Business Score [New Tab]'.

e Below are the Transaction Code details:

. . System Ena | Txn/Bal | Statemen
-Cl;)c()rgie Er?scrlptl Group ﬁ\ctlo ZZ? Defined | bled | Type t Txn
y (Yes/No) Type
pus_s | BUSINES | 257K
- S SCORE POST | N NO Y NONE NONE
CORE UPDATE MONET
ARY
Batch Manual State_me GL
nt Print
N Y N N
e Following are the transaction parameters and field details.
Sl. No | Field Name Field Format Mandatory | Default Value
1 TXN DATE Text Box with Calendar Y NA
2 SCORE RECEIVED Text Box with Calendar Y NA
DATE
3 SOURCE LOV [CRB_SOURCE_CD] | Y NA
[EXP/EFX/TUX]

4 SCORE Text Box Y 0
5 REFERENCE NUMBER | Text Box N
6 REASON CODE LOV [New LOV N

development WIP for Non-

Monetary Transactions]
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Sl. No

Field Name

Field Format

Mandatory

Default Value

COMMENTS

Text Box

N

]

Pl Drfaliy

Burkbneis Soore InfesTmathon

[ — b

Note: There is a validation to post this transaction only to the Business accounts.

Provided new “Business Score” tab, under ‘Customer Service > Customer Details >
Business’ to maintain the record of business score data.

| Fim g | W g

sy ELINIaLE

SRV

s Bacwna O

Rt T

o e agm

Boarding’ web service.

process.

2.14.2 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.15 Associate Non-Primary Asset to Account

2.15.1 Overview

A non-monetary transaction created to associate a non-primary asset to an Account.

2.15.2 Description

e A new non-monetary transaction “ADD NEW ASSET” created in OFSLL to associate
existing collateral to an Account.

e This transaction allow collaterals with status (NEW, INACTIVE and RELEASED) to
associate with Accounts.

o All the new Assets associated are with Primary indicator as N.

e On successful posting on this transaction, added a new record in Customer Service >
Collateral Management, Asset Relation and Asset Status History.

e A new comment “NEW COLLATERAL ADDED - ASSET NBR: XXX, PRIMARY IND: N”
is also posted on the Account.

2.15.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.16 Add Business and Add Existing Customer/Business (Ul

Only)

2.16.1 Overview

OFSLL accepts only one Business Applicant, whereas if an existing business bought over by
another business; which will encompass adding a new record of business name, TIN, and other
details on the account; and an update to the credit bureau to indicate the buy. There is no option
or transaction available to ADD NEW BUSINESS.

Enabled OFSLL to add new / existing Business to an Account from screen (instead of updating
the details from screen and transaction) and post non-monetary transaction for history.

2.16.2 Description

From customer service screen, user can add a new business to an account using ADD button
and user can add an existing customer business to the account using non-monetary transaction
Following are the changes done:

e Provided a ‘Add’ button and ‘Current’ indicator field in the Customer Service > Customer
Details > Business > Business Details

e On click of ‘Add’ button, system will show the following fields

Input/ . Data Field
Attribute | Description Selectable/ .?bJZCt (I\)/Iran\((ilal\'j Type/ | Valida \?:Ifjg;t
Display Only yp y Size tion
. | BUSINESS O

Oor:gf”'za“ RGANIZATIO | Selectable | LOV Y ((::tr;?ra NA E(gf\;ult

yp N_TYPE_CD
Type of BUSINESS_T Chara LOV
Business YPE_CD Selectable LOV Y cter NA Default

. CUSTOMER _
BUSINESS | - \TEGORY_ | Selectable | LOV Y Chara | \\ LOV
Category cb - cter Default
Name of
the Input Text Y Chara Null

. cter
Business
Legal Input Text Y Chara Null
Name cter

Less
Tax ID # Input Text Y Chara | than 9 |\
cter chara
cter
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Input/ . Data Field
Attribute | Description Selectable/ .?bj(th (I\)/Iranglal\tl Type/ | Valida Bzrjg;t
Display Only yp y Size tion
Shoul
d be
less
Input
Start Dt Calendar | Y Date than Null
/selectable
syste
m
date
Shoul
# of Numb d not
Employee Input Text Y be 0
er
s (Cur) less
than O
Shoul
# of Numb d not
Employee Input Text Y er be 0
s less
than 0
Contract Input Text N Chara Nul
person cter
Business Chara
Checking Input Text Y Null
cter
Bank
Bank Acc Input Text Y Chara Null
# cter
From Chara
Currency | Currency Selectable LOV Y cter NA Null
setup
Avg
Checking Input Text Y Chara Null
cter
Balance
Shoul
d not
# of Numb
Location Input Text Y er be 0
less
than O
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Input/ . Data Field
Attribute | Description Selectable/ .?bJZCt (I\)/Iran\((ilal\'j Type/ | Valida \?:Ifjg;t
Display Only yp y Size tion
Shoul
d not
be
greate
Manggem Input Text v Numb | rthan 0
ent Since er curren
t
syste
m
year
From
Payment | Payment Selectable | Text N Chara | o | Nl
Hierarchy | Hierarchy cter
setup

e On saving the record, system changes the existing records’ Current Indicator as ‘N’ and
new Business’s current indicator as ‘Y’ and creates the New Business Number. In this

case, none of the child records will be available/created.

e Onclick of ‘Save’, If TAX number is exist in the system, system shows a warning
‘Business Details exist with Same Tax Number’. With Ok.

e Following table illustrates on how system populates the credit limit details. These can be
visible on EDIT and VIEW

Adding Existing Business (B2
having limits)

Adding New Business(NB —
no limits)

If Linked
Business
having Limits
(B1)

Changes to B2

If Available Amt is less than
Liable Amount of contributed
Account, system should show
error message as ‘No limit
available to add the business.

Limit Expiry Dt should be greater
than or equal to account maturity
date

Adjust the limit as follows

Total Utilized Amt = Add Liable
amount to this field

Available Amt = Deduct ‘liable
amount’ from this field.

Change in Linked Business Limit
Details (B1)

Total Utilized Amt = reduce Liable
amount Amt to this field

Available Amt = add ‘liable
amount’ from this field.

Adjust the limit as follows
Max Limit = Liable amount

Total Utilized Amt = Liable
Amount

Available Amt =0
Hold Amt=0
Suspended Amt =0
Max Late Charge =0

Limit Expiry Date = Account
Maturity date

Next Limit Renewal = Account
Maturity date

Note: If user wants to update
the limits, use customer level
credit limit transactions
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Adding Existing Business (B2
having limits)

Adding New Business(NB —
no limits)

If Linked No impact on the Credit Limit No impact on the Credit Limit
Business not Fields Fields
having Limits

Reference: CreditLimits.xlsx

e Added the simulation sheet above for Credit Limit field's population.

o After this patch, if the ACC_BUSINESS_IND IS 'Y’, then only system enable Business
tab.

e If user using Business Tab to add a business, then system will post a non-monetary
transaction, ‘New Business Maintenance’ with transaction date as system date.

> In the result, system shows the message as, “Direct Record Update. Transaction
Posted Successfully.

e Added the following parameters to the transaction
e “Add Existing Business” non-monetary transaction

Parameter | Description | Mandat | Data Type/ | Field Default | Comments
Code ory Y/N | Size Validation Values
TXN Date | Transaction | Y Date Should be
Date equal to
System
Date
Existing Text field Y Varchar Na NONE if user
Business # select the
same
customer
number
linked to the
account,
validate on
post

e After posting this transaction, system will populate the details in business tab also and
changes the existing records’ Current Indicator as ‘N’ and new Business Customer’s
current indicator as ‘Y along with, populate the all child details (like address, Telecoms,
Partners...) on to this account.

“New Business Maintenance” non-monetary transaction

Parameter | Description | Mandatory | Data Type/ | Field Default | Comments
Code Y/N Size Validation | Values
TXN Date Transaction | Y Date Should be
Date equal to
System
Date
Organizatio | BUSINESS _ | Y Character NA LOV
n Type ORGANIZA Default
TION_TYPE
_CD
2-81 ORACLE

Financial Services



https://docs.oracle.com/cd/F16599_01/pdf/refdocs/ofsll_release_notes_attachments/CreditLimits.xlsx

Parameter | Description | Mandatory | Data Type/ | Field Default | Comments
Code Y/N Size Validation | Values
Business BUSINESS | Y Character NA LoV
Type TYPE_CD Default
Business CUSTOME Y Character NA LOV
Category R_CATEGO Default
RY_CD

Business Y Character Null
Name
Legal Y Character Null
Name
Tax ID # Y Character Exact 9 Null

character
Start Dt Y Date Should be | Null

less than

system

date
# of Y Number Should 0
Employees not be
(Cur) less than

0
# of Y Number Should 0
Employees not be

less than

0
Contract N Character Null
person
Business Y Character Null
Checking
Bank
Bank Acc # Y Character Null
Avg Y Character Null
Checking
Balance
# of Y Number Should 0
Location not be

less than

0
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Parameter | Description | Mandatory | Data Type/ | Field Default | Comments
Code YIN Size Validation | Values
Manageme Y Number Should 0
nt Since not be
greater
than
current
system
year
Payment From Y Character Based on | Null
Hierarchy payment sub code
Hierarchy
setup

e |f user post these transactions on to a non-business account, system show an error
“Cannot link/add business details to Individual Account”

e Added a Show All check box in the Business Details, by default it will show only the
current record. On click of the Show All, system will show the all records.

New Fields

e Added the following Read Only fields in the Customer and Business tabs and is visible on
click of Edit and View. These fields will not show in the header block

Header name as ‘Utilization Details”
e 9% of Utilization and Utilization Amount as number fields
e These two fields will get populated on funding the application with credit limits or while
adding the existing customer / business to an account if the account is under credit limits

2.16.3 Screen changes

After implementing the changes, screen appearance is as below:

Customer Service > Customer Details > Business > Add

Business Details
o Edit =| view || o Audit
View » Formatv [ Freeze B Detach Wrap @8 show a1 [J
Current Business # Organization Type  Type of Business  Business Category  Name of the Business Legal Name Tax 1D # Start Ot # of Emplo’
0
¥ 0000002051 CCORP CORPORATE Lending Leasing SOFTWARE SERVICES PYTLTD 005119 12/18/2017
i >
Business Details
Save and Add Save and Stay Save and Return | {3 Return
* Organization Type v * Business Checking Bank
*Type of Business ~ *Bank Acc #
* Business Category v * Aug Checking Balance 0.0
*Name of the Business * # of Locations 0
*Legal Mame * Management Since 0
*TaxID # Payment Hierarchy -
*Start Dt )
* 2 of Employees(Cur) 0
* # of Employees 0
Contact Person
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Customer Service > Customer Details > Business > Edit

Business Details

Business #

* Organization Type
*Type of Business
Business Category

* Name of the Business
* Legal Name

*TaxID #

* Start Dt

= = of Employees(Cur)
= = of Employees
Contact Person
*Business Checking Bank
*Bank Acc #

* Avg Checking Balance

* # of Locations

0000002051
C CORP

CORPORATE

LENDING LEASING
SOFTWARE SERVICES PYTLTD
ROOKELLD

12f182017 B

10

10

CONTACT PERSON

HDFC

2000010006 1065

1,234.01

5

*Management Since 745

Payment Hierarchy EQUAL AMOUNT

Credit Limit Details

Max Limit 0.00
Total Utlized Amt 0,00
Available Amt 0.00
Hold Amt 0.00
Suspended Amt 0,00
Grade
Max Late Charge 0.00
Limit Expiry  12/31/4000
Limit Next Renewal  12/31/4000

[ save andstay | [ save and Return

utilization Details

% of Utlization 0.00
Utiization Amount 0

{aRetum

Customer Service > Customer Details > Customer > Edit

[Asaveandstay || [ save andRetum || (aRetun
Customer Passpart #
@ Power of Attorney
Customer # 0000283010 fosuz Dt
Relation PRIMARY Expiry Dt ) Fower of Attorney [J
ECOA INDIVIDUAL Visa # Holder Name
tieme. LOANBLSINESS Nationality USA - Address
BrthDt 10/12/1987 [
National ID - - 0 Country 4
Marital Status v -
* S5 XX-K0X(-4500 Nationaiity -
Enabled v
License # Telephone Number
Language ENGLISH v
License State v
Education UNDEFINED v Credit Limit Details
Mother's Maiden Name Military Service et 100.000.00
x Limit 100,000,
*Class Type NORMAL v
Active Miitary Duty __ Total Utiized Amt - 25,000.00
Cate v
ategory Effective Dt Availsble Amt  75,000.00
Email Order Ref # Hold Amt 0.00
*Stop Correspondence [ Release Dt Suspended Amt 0.00
. Grade
* Disabiity (] Customer Decease Date By Max Late Charge. 0.00
lax Late Charge 0.
*skip [
Limit Expiry  12/31/4000
Bankruptey _ Krc imit Expiry  12/31/:
Limit Next Renewal - 12/31/4000
*privacy Opt out [
* Insurance Opt Out (] Reference # Utilization Details
* Marketing Opt Out [ Status ~
* Share Credit opt out [] % of Utlization 50,00
Existing CIF 0000011001 FATCA Utlization Amount 25000
Update Customer Info _
Birth Place
Identification Deta Birth Country %
S Do il

2.16.4 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.17 Lease Seed Data enhancement

2.17.1 Overview

Below are the sample fee balances provided in base for Lease

Inspection Fee
Damage Fees
Reconditioning Fees
Purchase Fee
Transportation Fee

2.17.2 Description

Following transactions codes are provided with Post, Reverse, Waive, Adjust Plus, Adjust

Minus, Charge Off/Write Off, Bill
> Inspection fee

» Damage Fees

> Reconditioning Fees

> Purchase Fee

> Transportation Fee

Along with this, following transaction parameters are provided for Post, Waive, Adjust

Plus, Adjust Minus, Charge Off/Write Off, and Waive
> Txn Date

> Amount

> Comment

2.17.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.18 Configurable Transaction Upload

2.18.1 Overview

OFSLL supports uploading the monetary and non-monetary transactions through flat file but does

not support the bulk upload and the input file delimiter is not configurable.

Now, this transaction upload functionality enhanced with bulk upload and make input file delimiter

as configurable.

2.18.2 Description

e Existing transaction upload file structure definition is provided in the Setup > Data Files >

Input

o Existing SET-IFP > INPUT DATA INSERTION (IDDPRC_BJ_000_01) batch job will
process the files under ITU folder as existing i.e., it will process the transaction with the
traditional process

e Introduced new SET-IFP > IDDPRC_BJ_000_02 > BULK INPUT DATA INSERTION
batch job which will work for when CLOB is ‘N’ and it will read the files from ITU folder
itself. After placing the file, if user runs this batch job, system will process the
files/transactions in bulk process.

> Each Transaction in uploaded file will recorded in Customer Service > External
Interfaces. Accept and Reject button will not be displayed for individual transactions

> If file having multiple transactions and any one transaction not valid then, system will
process all the valid transactions and generates a bad file with failed transactions

Dinta Files ] Close
Ourpt Inpat
Input Data File Definitions s | FER | [vien | of i
View > Format~ [ F 2 Dotact W "]
¢
Name File Name Description Directory Path Dedirmiter Record Format Erablod
ITU_TXN_UPLOAD TU_Tam L X - TXNS FILE UPLOAD m WARLABLE ¥
Column Definitions auadd | FEde [ View | o it
View = Format = [ R
Seq & Column Name Dt Tyt Format Mask  Length Sort Ersebled]
1 TUP_ACC_NER CHARACTER NOT APPLIC. o0 1 ¥
2 TuP_ID NOT APPLIC 30 ¥
i3 e _pOST_DT 3 ¥
TuP_ 10D cooe 1 Y
5 TUP_TXN_STATUS_CD 5 ¥
TUP_PARAMETERL_CD CO0E [ ¥
TUP_VALLUEL ¥
8 TUP_SIGN1 | 8 ¥
9 TUP_PARAMETER2 CD CODE CHARMCTER NOT APRLIC 9 ¥
10 TUP_VALLIEZ CHARACTIR. NOT APPLIC... 240 0 ¥
3 H . 1
Refer ‘Appendix: Seed Data’ chapter.
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2.19 Index / Margin Rate Change Monetary Transaction

2.19.1 Overview

OFSLL supports to overwrite the Rate as a while like Rate from X to Y say, 8% to 10%.

Request is to change the rate by 1% (i.e.) reduce rate by 1% from 8% to 7% or Increase by 2%

from 8% to 10%.

2.19.2 Description

e New ‘Adjustment Type’ transaction Parameter to RESCHEDULE_INDEX Monetary
Transaction as follows to update the margin rate by indicating either Increase or
Decrease with certain basis points

Parameter code

Default

Displayed? (Y/N)

Required? (Y/N)

Comment

Adjustment Type | Actual

N

N

Three Values
Actual
Increase

Decrease

o If Actual, system will work as existing. If user doesn’t enabled Displayed / Required,

system will refer the default value and perform the action accordingly
e Say, account having the following information

Index Type PRIME RATE
Index Rate 12.00

Margin Rate 4.99

Rate 16.99

e Now if user posted the transaction with Decrease - 1.2
System will post ‘RESCHEDULE_INDEX’ Transaction with Details as “INDEX= PR,

MARGIN RATE= 12.0000 AND FROM RATE =16.99 TO RATE 15.79”

> Updates the account information as

Index Type PRIME RATE
Index Rate 12.00

Margin Rate 3.79

Rate 15.79

System will also accrue the interest up to this transaction date with the old rate.

2.19.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.20 Account Transactions Get web service

2.20.1 Overview

New Get service that gives capability to get Transactions for an Account.

2.20.2 Description

A new Web Service to get Account Monetary Transaction Details. The service allows filtering the
data at a minimum based on Account Number, From Date, and To Date.

Those transactions which can see in Customer service > Transaction History >
Transactions [Ul will only show only few monetary transaction groups]

This service will send the list of all transactions posted by the user/system for specific
account along with payment allocation details.

In the request, following parameters are provided

> Account Number
» Transaction Type
» From Date

» To Date

Here both From and To Dates are inclusive and will refer the “Txn Dt” field in the

transaction history tab and

»  Only validation is, From Date should be less than or equal to To Date. From Date can
be less than Account Contract Date, and TO Date can be greater than System Date.

Only account number is mandatory; system will validate does it exist or not.

If user does not provide the Transaction Type, system will send the All Transactions.

If user does not provided the Dates, send all transactions.
> If From Date provided, system will send transactions from date to till system date.
> If To Date is provided, system will send the transactions from first transaction till To

Date.

Data shared in Descending order. i.e, latest records shown first.

Transaction Type options are as follows:

2.20.3 Seed Data

Transaction Type in WS Option | Reference ( Txn History > Txns > View Options)
PAY_GOOD Good Payments
PAY_ALL All Payments
FEE_GOOD Good Fees
FEE_ALL All Fees
ALL_GOOD Good Txns
ALL_ALL All Txns
Refer ‘Appendix: Seed Data’ chapter.
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2.21 RESTful Web Services

2.21.1 Overview

From 14.7.0.0.0 release, deprecated all the SOAP services from the base version.

RESTful Web Services enhanced with below changes:

e  Support for OAuth 2.0 authentication
e New Web Services
o Changes/Madifications to existing Web Services

2.21.2 Description
New/Update of RESTful Web Service

Categorized OFSLL Web Service enhancements as indicated below. The specification and
element descriptions of these services specified in Swagger documentation.

e New Web Services: Newly added in current release.
> Authentication-This service is used for Requesting Access token to access protected
OFSLL REST API
- Generate OAuth2.0 Token (POST)
- Validate OAuth2.0 Token (GET)

Note: For more details on OFSLL support on OAUTH2.0 refer to the OAuth
Implementation guide shared in OTN library:
https://docs.oracle.com/cd/F16599 0Ol1/references.htm

e Setup

> Webhook (POST, PUT and GET): Use this service to add, update and fetch
Webhook setup details.

e Vendor
> Vendor (POST,PUT and GET)
> Vendor Comments (POST and GET)
e Producer
» Producer (POST,PUT and GET)
> Producer Comments (POST and GET)
> Producer Contacts (POST and GET)
> Producer Compensation (GET)
» Producer Statements (GET)
» Producer Subvention (GET)
e Customer Service
> All Account Tracking Attributes (GET)
> Monetary Transaction History (GET)
e Collateral
> Asset (PUT)
> Asset Valuation (POST,PUT and GET)

e Update of Existing Services: Updated in request/response and underlying PL/SQL
record types
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> Customer Service

-

-

—

—

Account On-boarding (POST)
Account Details (GET)
Account Search Service (GET)
Payment Posting (POST)

> Customer

—

Customer Payment Posting (POST)

> Business

—

Business Payment Posting (POST)

> Collateral

-

2.21.3 Seed Data

Asset (POST,GET)

Refer ‘Appendix: Seed Data’ chapter.
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2.22 Producer web services

2.22.1 Overview

Provided new set of Producer RESTful Web Services.

2.22.2 Description

Introduced the following new RESTful Web Services.

Service Purpose Method
Producer On boarding To post Producer details with information like name, POST
services - Details Block address etc.,
To update Producer details like name, address etc., PUT
To query and fetch Producer information like name, GET

address etc.,

Producer - Contact To post Producer contact details POST
Producer > Compensation | To get Producer Compensation Details GET
Producer - Subvention To get Producer Subvention Details GET
Producer - Holdback & To get Producer Holdback and Reserve Details GET
Reserve
Producer > Statements To get Producer Statement Details GET
Producer > Comment To post the comment in Producer tab using Producer | POST
ID
To fetch the comment in Producer tab using GET
Producer ID

e For Producer POST service

> If the system parameter UVYN_PRO_NBR_SYS GENERATED is ‘Y’, system ignores
Producer Number element and generates the number.

> If this parameter is ‘N”, Producer Number element is mandatory and unique
constraint validation happens.

2.22.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.23 Vendor web services

2.23.1 Overview

Provided Vendor RESTful Web Services.

2.23.2 Description

Introduced the following new RESTful Web Services.

Service Purpose Method
Vendor On To post Vendor details with information like name, address etc. | POST
boarding services

- Details Block To update Vendor details like name, address etc. PUT

To query and fetch Vendor information like name, address etc. | GET

Vendor > To post the comment in Vendor tab using Vendor 1D POST
Comment

To fetch the comment in Vendor tab using Vendor ID GET

e For Vendor POST service,

> If the system parameter UVYN_VEN_NBR_SYS_GENERATED is 'Y’, system ignores
Vendor Number element and generates the number.

> If this parameter is ‘N”, Vendor Number element is mandatory and unique constraint
validation happens.

2.23.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.

2-92 ORACLE

Financial Services



2.24 Collate

ral web services and File Upload

2.24.1 Overview

Provided Collateral RESTful Web Services. Using the file upload system creates the collateral
details, valuation, add-ons and tracking attributes.

2.24.2 Description

Introduced the following new RESTful Web Services.

Service

Purpose Method

Collateral Management = | To update collateral details using the asset number | PUT
Collateral Details Block

Collateral Management = | To update collateral valuation details PUT

Collateral Details >

Valuation Block To create collateral valuation details POST
To get collateral valuation details GET

Modified Services

Collateral Management = | Create the collateral details and link to an account | POST
Collateral Details Block

Get the collateral details using the account number | GET

e ‘Create Collateral’ file upload

Provided new input folder called ‘ICC’ along with the system parameter to specify the
folder location

Provide the setup configuration under Setup > Data Files > Input

Use the existing SET-IFP batch job (IDDPRC_BJ_000_02 - BULK INPUT DATA
INSERTION) to process this input file

While processing the files, system refers to the data file setup, maps the data with
column name and then validates.

e Using this service, user can create and update the collateral details including valuation,

add

-ons and tracking attributes.

e As part of the response, system generates processed/bad/error file in the input > ICC > >
Processed folder.

e Collateral Update File- using this service, user should be able to update following in bulk

Details — using the Asset number user should able to update the details.

- If no data provided, field left blank.

- If the data is exist, system validates the data and updates the value.
Valuation — using the asset number, user can update the current valuation only

- Add On — using the asset number, user should able to update the current
valuation’s add-on details

Tracking Attributes — using the asset number and tracking item, user should able to
update the tracking attribute values. To update the multiple tracking items for single
asset, user should send it in multiple records with different tracking item.

e ‘Operation Ind’ refers to the Create (I) or Update (U) the record.
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Note: In this release, system does not use the existing input file CLOB parameter
(CMN_FILE_PROCESS_TO_LOB) for processing these files. i.e., it will work only for ‘N’

In the Setup > Data Files > Input tab providing the seed data with the file structure

Outot Input

Input Data File Definitions
Nw v Forrat + [0 1 ez
L
[
ASEET_ASE_UR OADY
ASSET_ATA URLOAD
ASSET_ATR URLOAD
ASSET_AVL_UPLOAD

Column Definitions

View = Forrot = [ Freese
seq Column Nome
& PSE_OVERATION. IND
2z MSE_NER
3 ASE_ORIG_SYS_XREF
4 ASE_COLLATERAL_TYPE_CD

ASE_PRIMARY_TND
ASE_ASSET_C1ASS_(T

f

il ASE_AST TYPE

8 ASE_ NS TYIE

9 ASE_ PEGISTRATION NER
0 ASE_YEAR

B Detach

File Neme
TUT_ASE_UPLOAD. OS5V
IUT_ATA UPLOWD.CSY
IUT_ATR LRLOAD.CSY
IUT_AVL_LRLOAD.CSY

B petach a4 Wrag

Cohamn Descrigtion
DPERATION IND.
ASSET MUMBER
WFEF

COLLATERAL TYPE
PRIMARY

ASSET CLASS
ASSLT TYPL
SUE TYPE

REGISTRATION ¥
VEAR

Descrigtion

ASSET FILE LPLOAD

ASSET TRACKING ATTRIBUTES FILE UPLOKD
ASSET ADDONS FILE LPLOAD

ASSET VALUATIONS FILE UPLOAD

Data Type
CHARALTER
CHARACTER
CHARACTER.
CHARACTER
CHARACTER
CHARACTTR
CHARACTER
CHASATER
CHARACTER
HUMBER

Darectory Path
o
o
o
[l

Forrnot Mask
NOT MLIC..,
NOT APPLIC.
NOT APRLIC. .,
NOT APPLIC
NOT APPLIC
NOT KPP
NOT APRLIC,.
NOT APLIC,
NOT APPLIC. .
FEROFILL 4 ..,

Delimiter

Length

30

a0

a0
30

padd | Fedn | [ view | o pude

o Format Frabied
WARLALF ¥
VARLAGLE ¥
VARLASLE ¥
VARLAALE ¥

o | P | [view | o rode

Sort Enatied
1 ¥ ~
2 ¥
3 ¥
a ¥
¥
6 ¥
7 ¥
8 ¥
L] ¥
10 ¥ w

Sample File

Reference: IUT _ASE UPLOAD.csv

2.24.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.25 Rescission Account - Non-Monetary Transaction

2.25.1 Overview

OFSLL ‘generic post transaction RESTful service’ does not allow any reversal transactions. From
the third party system user should void an account in OFSLL using the Web Service.

2.25.2 Description

e Provided new Rescission Account non-monetary transaction with transaction date,
using this transaction user can able to void any type of account (loan/line/lease) and
status should be ‘ACTIVE’ and ‘TERMINATE’.

> Also, existing validations on ‘Transaction History > Transactions > Active > Reverse’
will be applicable for this transaction.

> System does not allow to post if account status is in ‘Void’ status.

e System will check the account backdate date which should be less than or equal to the
accounts activation date.

> If not, an error “Backdating of Transaction is allowed for date after <account backdate
date> only” will be shown.

> If user wants to void a Paid or Charged Off account, user need to reverse the
transaction from the Ul and can post this transaction to void an account.

e System posts the ‘REVERSE ACTIVE' transaction and change the following:
> Account status to ‘Void'.
» Corresponding Application status to ‘Void’, if exist.
> Reverses all the Good Transactions on to the account.
e Transaction parameters are:
» Txn Date, which should be equal to the System Date
> Reason

2.25.3 Seed Data

Refer ‘Appendix: Seed Data’ chapter.
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2.26 Link Customer Based on Customer Number

A new system parameter “AUTO GENERATE BUSINESS NUMBER FOR CONVERSION
PROCESS" is introduced to determine if the Customer Number should be generated
automatically or provided by external interface.

UpdateCustomerinfo: This filed is used to update existing customer details with new details
provided as part of the new Account on-boarding request.

LinkExistingCustomerind: This field is used to link existing customer provided with new
Account. If Customer ID is not provided then system will search with SSN/National ID and
associate existing Customer with new Account. If Customer ID is provided then system will
validate SSN/National ID and associate it with new Account.

OFSLL
LinkExisting Has
SNO | Cusld Customerind | Customer | Description

System will search Customer based on CusID,
validate CusID with SSN/National ID and associate
1 Y Y Y new Account with matched customer

System will create new customer and associate to
2 N N N new Account

System will search Customer based on CusID and on
3 Y Y N no match found system will throw error

System will search Customer based on SSN/National
4 N Y Y ID and associate new Account with matched customer

System will create new customer and associate to
5 N Y N new Account

A new system parameter “LINK CUSTOMER BY CUSTOMER NBR/ID” should be created to
toggle logic of associating to existing customer between Customer ID and Customer Number.

If the values is CUSTOMER ID, then existing logic continues. If the value is CUSTOMER NBR,
then new logic will be written to associate based on Customer Number and not validate using
SSN/National ID.

CusNb | LinkExisting | OFSLL Has
SNO |r Customerind | Customer Description

System will search Customer based on CusNbr
1 Y Y Y and associate new Account with matched customer

System will create new customer and associate to
2 N N N new Account

System will search Customer based on CusNbr
and on no match found

System will throw Error — If create customer
3 Y Y N system parameter is N
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CusNb | LinkExisting | OFSLL Has
SNO |r Customerind | Customer Description
System will create Customer — If create customer
system parameter is Y
4 N Y Y System will throw error
5 N Y N System will throw error

Also, the following additional parameters are introduced:

Parameter Name

Description

SYP_AUTO_GEN_BUS_NBR

(AUTO GENERATE BUSINESS
NUMBER FOR CONVERSION
PROCESS)

During Account on-boarding/conversion process, this system
parameter is used to determine if Business Number is to be
generated by OFSLL (if set as Yes) or provided by External
System (if set as No).

SYP_AUTO_GEN_ASE_NBR

(AUTO GENERATE ASSET
NUMBER FOR CONVERSION
PROCESS)

During Account on-boarding/conversion process, this system
parameter is used to determine if Asset Number is to be
generated by OFSLL (if set as Yes) or provided by External
System (if set as No).

UPR_PRO_NBR_SYS_GENERATED

(PRODUCER NUMBER IS SYSTEM
GENERATED)

During new Producer creation, this system parameter is used
to determine if Producer Number is to be generated by
OFSLL (if set as Yes) or provided by External System (if set
as No).

UVN_VEN_NBR_SYS_GENERATED

(VENDOR NUMBER IS SYSTEM
GENERATED)

During new Vendor creation, this system parameter is used
to determine if Vendor Number is to be generated by OFSLL
(if set as Yes) or provided by External System (if set as No).
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3. Appendix: Seed Data

Seed data for all the impacted modules against specific enhancement is available in the below
location.

OTN Documentation Library - Seed Data 14.7.0.0.0.pdf
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https://docs.oracle.com/cd/F16599_01/pdf/refdocs/ofsll_release_notes_attachments/Seed_Data_14.7.0.0.0.pdf

4.Patches and Bugs

Bug Id

Bug Description

Fix Description

NA

NA

NA
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-NA-

5-1

5. Security Fixes

ORACLE

Financial Services



-NA-

6. Limitations and Open issues
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7.Components of the Software

7.1 Documents accompanying the software

The various documents accompanying the software are as follows:

e Product Release Notes
e Product Installation Guide
e Installer Kit

e User Manuals and Installation manuals - These can be accessed from the link
https://docs.oracle.com/cd/F16599 01/index.htm

7.2 Software Components

Software Components of this patch release are as follows:

e Core
> Ul Components Ear file (JSF, XML, XLF, JSFF)
» Stored Procedures (Packages, Views, Java Stored procedures)
> Reporting Components(Data models(xdm), Reports(xdo, rtf))
> BIP /canned reports
e Interface
» Stored Procedures (Packages, Views, Types)
> The WSDL files for the service supported
»  XSD Structure (dictionary) for the web service
> Configuration files for the web service
> Java classes for the web service
> The service documents — describing the services
>  Extensibility Document — Describes customization for the services.
e Installation utilities
>  Script based installation for Database components
> Installation documents for Database, Ul, Web services
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https://docs.oracle.com/cd/F16599_01/index.htm

8. Annexure — A: Environment Details

Component Deployment Machine CpEiEing Software Version
option System
Oracle WebLogic
Enterprise
Edition(Fusion
Middleware 12.2.1.3.0
Infrastructure installer
—includes ADF and
Application Oracle RCY)
server Enterprise
Linux 6.7+
&7.0 (64 Oracle JDK 1.8.0_202
Bit) and
Sun .
Application
.SPARC Development 12.2.1.3.0
with Oracle Eramework
Solaris 11
(64 BiY 12.1.0.2.0/
Database Oracle Database
Server Enterprise Edition 12.2.0.1.0/
18.3.0.0.0
Oracle Reporting Oracle Business 12.2.1.3.0/
Financial , Server Intelligence Publisher | 12.2.1.4.0
Services Centralized
Lending and o _ .
Leasing Windows 7 Microsoft Internet
(Patch Explorer 11347'%%1071
Version (64 Bit) ‘
6.1)
Mozilla Firefox
(32 Bit) 60.6.3esr
Google Chrome 74.0.3729.
(64 Bit) 131
Mgclzlf?irr]]tes Windows Microsoft Edge | 42.17134.1
10 (Patch (64 Bit) .0
Version
1703) Mozilla Firefox
(64 Bit) 66.0.4
Google Chrome 74.0.3729.
(64 Bit) 131
Mac OS X Apple Safari
(64 Bit) 12.2
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9. Annexure — B: Third Party Software Details

For information on Third Party Software Details, refer to Licensing guide available in OTN library -
https://docs.oracle.com/cd/F16599 01/pdf/refdocs/Licensing Guide.pdf
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